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Foreword 

The strategy adopted in Lhe formulation of the International Centre for Science and 
High Technology (JCS) Wc,rk Programme is to promote a policy of sustainable develop­
ment which takes into ac::count the industrial capacity of developing and emerging 
countries as well as environmental issues. This in line with the conclusions emerging 
from the 1992 Ri.o Conference, Agenda 21, which resulted from that conference, and 
ensuing international forums, and in particular with the recommendations of the Italian 
Ministry of Foreign Affairs and of the United Nations Industrial Development Organi­
zation (UNIDO). 

In particular, pollution prevention and technologies based on renewable re­
sources have been taken into consideration when formulating subprogrammes that 
propose intervention within industrial cycles rather than "end-of-pipe" solutions. This 
approach is applied to the majority of ICS Subprogrammes carried out under three 
main technical areas: 

0 Pure and Applied Chemistry 

0 Earth, Environmental and Marine Sciences and Technologies 

0 High Technology and New Materials 

Some activities, stiJ based on post factum interventions-e.g., bioremediation, 
waste water treatment and recycling of plastic materials-are planned in terms of their 
relevance in addressing environmental problems. 

Alongside these activities a programme that provides support tools for technol­
ogy transfer management is based at UNIDO Headquarters in Vienna. It focuses on 
technology and environmental management, business alliances, technology and com­
petitiveness, services for research and development centre, benchmarking and needs 
assessment. 

The ultimate goal of JCS strategy is to benefit developing countries and countries 
with economies in transition through technology transfer, institutional capacity build­
ing and development of human resources. Each of the JCS activities is tailored to the 
objectives of individual beneficiaries, focusing on the industrial conditions of the tar­
geted countries. 

To support all ICS activities, information system tools are being developed to 
expand and enhance in- 1ouse capacity and expertise. These tools include the Best 
Available Technologies Economically Viable (BATEY) database; software and math­
ematical models for simdation of industrial processes and chemical compounds; and 
software and mathematical models for "image engineering". 

These tools are valuable in training technical experts from developing countries 
as well as providing diae,nostic services in support of project formulation. Known as 
decision-support systems (DSS), they aid in pre-assessment of technological, economic 
and ecological viability of projects. 

In particular, geognphic information systems (GIS) are taking on increasing im­
portance for planners and decision makers concerned with problem domains that in­
clude spatial dimensions such as natural resources, environmental management, urban 
and regional development planning, agricultural assessment, and industrial site survey 
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and optimization. The use of GrS together with remote sensing, process simulation and 
dedicated expert systems represents the final goal of the strategy of res. 

This manual presents an introduction to GrS for use in industrial development. 
The application of GIS and its use in combination with remote sensing are illustrated 
by examples of environmental information and decision-support systems. These in­
clude case-study demonstrations on urban land-use classification and on multi-criteria 
evaluation for industrial siting. 

All res activities relating to the subject of this training package are closely co­
ordinated with ongoing or planned UNIDO programmes in line with its newly revised 
strategy, and are jointly undertaken with the relevant branches at UNIDO Headquar­
ters. 

U:\'IDO-ICS joint projects follow UNIDO procedure for project development, 
funding and implementation. 

We look forward to working with you, and to receiving your comments on this 
training package. 
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1 lntroduct'ion 'to geographic information 
systems 'for industrial deyelopment* 

In the industrialized worlci, new methods and theories for environmental assessment 
and analysis are in a phas1~ of expansion. These focus on the combined application of 
decision support systems a rrd expert systems with geographic information systems and 
remote sensing input and output, bringing a massive expansion in the analytical capa­
bilities available today in the field of applied environmental research and pollution 
prevention. 

This training package is a contribution to those new environmental methods and 
theories. It has been developed within the Decision Support Systems (DSS) 
Subprogramme, which supports the diffusion, integrated use and effective application 
of the GIS instruments and methods, and increased cooperation with developing coun­
tries. This means presenting a common "interface" and approach to tackling problems 
through networking and tE:chnology transfer. Activities include training in new tech­
niques and demonstrations of practical case studies that have been developed at the 
local level or taking into consideration conditions at the local level and, in addition, 
channels are being established for sharing results, knowledge, standards and method­
ologies. Projects are then being developed in close cooperation with national counter­
parts. One goal is the enrrancement of existing investment. Apart from acquiring 
knowledge in computer applications for integration of geographic information systems, 
decision support systems, remote sensing and image engineering, beneficiaries (local 
authorities and decision makers) will be made aware of the need to develop shared 
information resources. To date, high costs and inaccessibility of resources have been a 
major hindrance to environmental scientists, planning offices and decision makers. 

The DSS Subprograrnme links to the coastal zone management (CZM) Subpro­
gramme by introducing GIS tools for landscape assessment in coastal areas. Both Sub­
programmes have the objective, in line with general res strategies, of technology trans­
fer to developing countries to improve their capacity building. The DSS Subprogramme 
is more oriented to the trar.sfer of technological tools of the decision domain while the 
CZM Subprogramme allow~; the application of these tools to coastal zone management. 

1. 1. General obiective of the DSS Subprogramme 

The DSS Subprogramme highlights the decision-making process at the policy /regula­
tory level in developing ccuntries related to the formulation and implementation of 
national or sub-national (ar1~a-wide) polices, strategies and action plans for sustainable 
industrial development. Its main objectives are: 

0 To introduce GIS concepts, allowing collaboration between technicians and 
industrial planners; 

'This chapter was prepared by E. Feoli and M. Ghribi, Area of Earth, Environmental and Marine 
Sciences and Technologies, JCS-Uf'IIDO. 
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0 To develop regional projects with a focus on the impact of industrial devel­
opment on peri-urban areas and on environmental plans for pollution con­
trol; 

0 To strengthen research in environmental sciences; 

0 To enhance a dynamic training network in integrated environmental appli­
cations; 

0 To promote regional cooperation. 

1.2. Obiectives of the training package 

This training package is the first of several and allows for building other similar pack­
ages. It has been designed for training, educational needs and scientific information. 

The immediate objectives are: 

0 To foster the formulation of projects suitable for applying technologies of 
the decision domain (GIS, image processing, image engineering, remote sens­
ing, decision support systems, artificial intelligence techniques etc.) to sup­
port the industrial development of developing countries; 

0 To promote the creation of small enterprises that will assist small and 
medium enterprises (SlVIEs) to use environmental management system 
technologies and to assist planners and decision makers in environmental 
impact assessment and risk assessment and management of industrial 
areas; 

0 To develop a link between GIS technology and technology databases (e.g., 
BATEY), especially those in use at UNIDO. 

1.3. Target clients 

In general, GIS technology is applied in numerous fields such as forestry, agriculture, 
marine science, market research, public health, facilities management, habitat assess­
ment, environmental science, cartography, geology, business, engineering and govern­
ment. 

GIS users include engineers, technologists, technicians, business people, entrepre­
neurs, researchers, database managers and information specialists. GIS technology is 
also applied by coordinators and technicians for municipal services, police forces and 
fire services, and by those in the fields of natural resources and telecommunications. 

The target clients for the training package are analysts and institutions with 
clearly defined responsibilities for supporting the decision-making process of regula­
tory agencies and policy makers at national (area-wide) levels. These may include gov­
ernmental agencies (e.g., ministries of industry, planning, or environment), industrial 
associations, chambers of commerce, academic institutions and consultants working in 
direct contact with decision makers. 

1.4. Decision domain and sustainable development 

The targeted decision domain relates to the design and implementation of policy and 
regulatory mechanisms addressing the following topics: 
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1.4. 1. National or regional development 

This includes spatial and ~;tructural industrial development planning and its typical 
activities such as: 

0 Siting, environr:i.ental impact assessment 

0 Zoning, environmental quality objectives 

0 Planning clusters of industries 

0 Infrastructure planning 

0 Cross-sector coJrdination 

1.4.2. Pollution prevention 

This focuses on incentives and regulation at the enterprise level to promote: 

0 Technology innovation, implementation of International Organization for 
Standardization (ISO) standards 

0 Cleaner production (reducing waste and pollutants at the source, energy 
saving etc) 

0 Pollution contrcl and waste treatment (end-of-pipe/stack), monitoring tech­
niques and monitoring systems 

1.4.3. Industrial risk 

The control and management of: 

0 Toxic waste and hazardous substances 

0 Chemical safety 

0 Risk assessmenL and emergency planning 

1.5. Technological t·ools 

Technological tools for use in the decision domain for sustainable industrial develop­
ment include geographic information systems, decision support systems, process simu­
lation, expert systems and remote sensing. Developing countries have requested train­
ing courses in these topics. Application of these tools must be implemented in specific 
research and development (R and D) projects. At ICS, a considerable amount of GIS 
software is available and can be used in R and D projects. However, for this training 
package a set of software with wide diffusion has been chosen that has a relatively low 
cost and is already used by other United Nations organizations, namely IDRISI for 
raster-based GIS applications, and ArcView for vector data models. 

The training package is divided into two sections. The first section explains the 
theoretical concepts of GIS and its application and the second section introduces the 
use of GIS with a set of ex,~rcises and case study demonstrations. The ICS-GIS group 

is also interested in workin~, with Multi-fold Ground-Penetrating Radar (GPR). To learn 
more about this technology. please refer to the appendix. 

Finally, a CD-ROM containing the authors' contributions will be developed and 
inserted with the whole package. 
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2 The GIS c:Jat~1 model and 
raster-based GIS applications* 

2. 1. Obiectives 

This section of the manual aims to assist the student: 

0 To understand the nature of the GIS data model 

0 To recognize technical raster and vector data issues 

0 To identify raster-based GIS applications 

2.2. Handing spat'ial data with GIS 

There are three approach~s to handling spatial data with GIS. They are the: 

0 Raster model 

0 Vector model '.points, lines, polygons) 

0 Object-oriented model (objects stored in linked tables) 

2.3. Representation of features in GIS 

Geographic information systems provide a powerful set of tools for collecting, storing, 
retrieving, transforming and displaying spatial data from the real world for a particular 
set of purposes. They differ according to the data model that is used to store databases. 
The GIS is based on its ability to combine many data sets and display them in a 

common framework as thematic maps. 
To obtain thematic maps the GIS may have internal software tools for database 

and data analysis and image processing, or may be easily interfaced with external 
software. There are many geographic information systems on the market, in both the 
commercial and public domains. Depending on how they have been designed (l], they 
can answer the following: 

0 Location. Determine what exists at a particular location (using points, 
lines, polygorn;, or a buffer area around any such feature); 

0 Spatial identification. Find locations where certain conditions are satisfied. 
This will inclu::le the logical (Boolean) or arithmetic combination of multiple 
data layers (overlay analysis); 

0 Trends. Find the differences within an area over time or along spatial 
dimensions; 

'This chapter was prepared by E. Feoli and M. Ghribi, Area of Earth, Environmental and Marine 
Sciences and Technologies, ICS-UNIDO. 
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0 Patterns. Correlate different attributes and calculate similarity between 
patches, fractals, landscape indices etc. 

0 Modelling. Answer "What if' questions. 

Analysis in GIS is based on the map paradigm; for maps of inherently static 
objects analysis is based on map overlays using Boolean expressions. To answer more 
complex questions, one needs to combine (static) geographic data layers with dynamic 
and spatially distributed models. The most common data storage formats are "raster" 
and "vector" data structures [2]. 

Later we will examine each data structure in detail and comment on the advan­
tages and disadvantages of each. Most discussions now are focused on which data 
structure is more appropriate for an application. This has grown from the realization 
that both data structures are useful and in turn has led to research into methods for 
combining the data structures. 

2.4. Where do data come from? 

A geographic information system is a set of computer tools designed to efficiently 
capture, store, update, manipulate, analyse, and display all forms of geographicly ref­
erenced information [3]. A GIS typically links data from different sets, using geo-refer­
encing, i.e., spatial coordinates, as a common key between different databases as illus­
trated in figure 2.1: 

Figure 2. 1. Sources of data used in GIS 

• Paper maps • Aerial photographs • Satellite images 
• Electronic maps • Radar (e.g., Landsat and SPOT) 

• Digitizing • Interpretation • Pixel values 
• Scanning 

2.4. 1. Data integration, transformation and analysis 

The main procedures for data integration, transformation and analysis are: 

0 Overlay of maps (Landsat Thematic Mapper) 

0 Distance analysis (planning of infrastructure) 

0 '.\ieighbourhood analysis (water run-off models) 

0 Spatial filtering (smoothing of data) 

0 Interpolation (inverse distance) 

CJ Principal component analysis of map layers 

CJ Correlation between map layers 

0 Clustering of pixel values 
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2.4.2. Errors in GIS sources 

Errors in GIS result from data input, digitizing, interpretation and conversion of raster 
data to vector data and vice versa. 

2.5. Cartog1raphic model of GIS 

In a layer-based GIS, the data for a geographic region can be visualized as layers of a 
map. The term "cartographic model" is used to describe a set of data (database) describ­
ing selected characteristics of each location within a bounded geographic area in the 
form of map-like layers (see figure 2.2). 

Figure 2.2. A GIS cal'tographic layer model in which an asrct of reality or 
parameter is represented by each layer [2 

A map layer is a set of data describing a characteristic of each location within a 
bounded geographic area. The nomenclature used may vary from one system to an­
other but the principle is the same. The map layer is essentially a parametric approach 
to representing the real world in a GIS database. One item of data is available for each 
location within a single layer and multiple items of information require multiple layers. 

One of the most important benefits of a GIS is the ability to spatially interrelate 
multiple types of information stemming from a range of sources. This concept is illus­
trated in figure 2.3, which shows a GIS study for soil erosion in a watershed [4]. 
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Figure 2.3. GIS analysis procedure for studying potential soil erosion [4] 
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(a) Source maps that have been geo-coded cell-by-cell 
(b) A series of land data files or layers 
(c) Sources of derived data that can be interrelated by the analyst 
(d) Analysis of each cell 
(e) Output analysis 

2.6. Raster file structure 

;.\NALYSlS OUTPUT 

Raster data represent geographic features and variation as image files [5]. Each image 
consists of a defined number of rows and columns thus forming cells or pixels. These 
units are stored as a sequence of numbers (byte, integer or real number) representing 
values such as vegetation class codes, reflectance numbers, landscape patches, or z­
values (e.g. altitude) in a digital elevation model (DEM). 

2.6.1. Structure 

A grid (5 columns, 4 rows) is a special type of raster where the value stored is a record 
in a table that stores additional descriptive information for the cells (i.e., legend) as 
shown below: 

0 1 2 3 4 

0 22 22 18 18 18 

I 15 15 ,18 llll 
21115 15 rn II 
:i II 15 [ii] [ii] [ii] 

Values may represent some code for landscape categories. In the simplest format 
"ASCII" the cell values and its categories are stored one in each line: 

II Industrial Area 

\12 Water 

15 Commercial Zone 

I Parks 

18 Agriculture 

22 Residential sites 
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To summarize, a ras :er data model has the following characteristics: 

0 The model consists of rows and columns of cells (array) 

0 Area of cell equals spatial resolution 

0 Value for each cell records type of object or condition 

0 Cells do not correspond to spatial entities in the real world 

0 Cells are considered homogeneous units 

2. 6.2. Definitions 

Pixel. The smallest indivsible element that makes up an image. In raster processing, 
data are represented spatially on a matrix of grid cells, called pixels, which are as­
signed values f?r image characteristics. 

Resolution. A measure of the accuracy or detail of graphic display, expressed as dots 
per inch, pixels per line, lines per millimeter etc. 

Spatial resolution. The accuracy associated with the capture of ground information as 
reproduced in digital format or graphic display. 

2.7. Vector file st1ructure 

Vector data represent geographic features and variation as points, lines or area objects 
that specify locations or Joundaries, and store information about the objects. The at­
tributes are stored with a traditional database management software program. The 
elements or components of the spatial data in vector-based GIS are constructed from 
the graphic primitives, as shown below: 

+ [/ 

+ T + 
+ + 

/ \ 
++ + I 

Points Lines Areas 

Point features. These could be used to represent the position of an industrial plant, a 
soil sample location, a meteorological station or the corner of a land parcel. In GIS, 
points are also important as they mark the position where two lines intersect (e.g., 
cross of two rivers). 

Line features. These comprise two or more points and consequently have a length but 
no area. Lines are used to represent features such as roads, rivers and boundaries. 

Area features. These features comprise a series of one or more lines. They have both 
area and perimeter length. Areas represent features such as soil types, vegetation and 
land ownership parcels. 
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2.8. Storing data types 

Apart from describing objects by points, lines and polygons, it is also necessary to 
specify the location by mapping the earth surface onto a flat, Cartesian coordinate x, 
y system, where each point is recorded as a single (x, y) location. Lines are recorded 
as series of ordered x, y coordinates and areas are defined by an ordered set of co­
ordinates that define their boundary. 

Unfortunately the Cartesian coordinate system is only suitable for objects that 
require uniform units such as meters. When geographic features are presented on a 
map they have to be projected mathematically from a spherical globe onto a flat map. 
The only problem with projection is distortion, such as stretching and shifting. The 
most popular projections are Universal Transverse Mercator (UTM), Lambert Conic 
Conformal (LCC) and Albert Conic Equal-Area (ACEA). Latitude and longitude, which 
measure features in degrees from the earth's centre rather than at the earth's surface, 
are not considered a map projection coordinate system [6]. 

In summary, vector data model precisely position features in space and are con-
structed using the following elements: 

0 Points, nodes (single x, y coordinate pair) 

0 Lines, arcs (series of x, y coordinate pairs) 

0 Area, polygons (area as closed loop of x, y coordinate pairs). 

2.9. Comparison of raster and vector models 

Objects from the real world: 

0 Coordinate system: UTM, latitude-longitude etc. 

0 Attributes: Colour, pH, soil, vegetation etc. 

0 Topology: How objects are related 

Figure 2.4. GIS raster vector layer models [2] 
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Raster Model 

Advantages 

0 It is a simple data structure; 
0 Overlay operations are easily 

and efficiently implemented; 
0 High spatial variability is efficiently 

represented in a raster format; 
0 The raster format is mere or less 

required for efficient mmipulation and 
enhancement of digital • mages; 

0 Satellite data (a major cata source) 
are in raster format. 

Disadvantages 

0 The raster data structure is less 
compact; data compression techniques 
can often overcome thb problem; 

0 Topological relationship;; are more 
difficult to represent; 

0 The output of graphics is less 
aesthetically pleasing b(:cause 
boundaries tend to have a blocky 
appearance rather than the smooth 
lines of hand-drawn maps. This can be 
overcome by using a very large number 
of cells, but may result in unacceptably 
large files. 

Vector Model 

Advantages 

0 It provides a more compact data 
structure than the raster model; 

0 It provides efficient encoding of 
topology, and, as a result, more 
efficient implementation of 
operations that require topological 
information, such as network 
analysis; 

0 The vector model is better suited to 
supporting graphics that closely 
approximate hand-drawn maps; 

0 It gives a good representation of the 
world, as we perceive it. 

Disadvantages 

0 It is a more complex data structure 
than a simple raster; 

0 Overlay operations are more difficult 
to implement; 

0 The representation of high spatial 
variability is inefficient; 

0 Manipulation and enhancement of 
digital images can not be effectively 
done in the vector domain. 

2. 1 O. GIS tools and data analysis 

Many GIS have internal data analysis and image processing functions that can calcu­
late different pattern indices such as fragmentation, fractal, entropy, etc. [7]. With GIS 
tools such as IDRIS! and GRASS, it is possible to treat remote sensing data coming 
from the LANDSAT programme of the United States, the French system (Systeme 
pour !'Observation de la lerre "SPOT"), the United States National Oceanographic and 
Atmospheric Administration (NOAA) and other sources by using the maximum like­
lihood algorithm and Fuz:~y set theory. 

GRASS also allows the use of sophisticated neural network algorithms [8; 9; 1 OJ; 
however these GIS do not offer the possibility of treating ancillary data of specific 
operational geographic units (OGU). OGU are pixels, polygons and sets of pixels and 
polygons (illustrated in figure 2.5) and are used for hierarchical classifications and 
ordinations by methods such as cluster analysis and factor analysis [11] or fuzzy set 
theory [12]. These methods are still available only in external packages. 

All modern GIS support convenient data import and export functions, and many 
packages are available for data analysis. However, with the exception of the "maximum 
likelihood" method, they rarely include methods of classification and ordination based 
on probability [13]. The advantages of using such functions derive from the fact that 
similarity between OGUs may be tested in a probabilistic way within the data sets 
representing the system under study. With probabilistic similarity functions, the simi­
larity may be tested within and between time intervals. These functions, based on 
Goodall's probabilistic index [14], have been included in the information system devel­
oped by ICS-UNIDO [15], especially for applications in coastal zone management and 
for treating remote sensir.g data [ 16]. 
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3 Topologic:al overlay and 
mathematicc1I operations with GIS* 

3. 1. Overlay analy:sis 

The overlay function can perform simple operations, such as laying a road map over 
a map of local wetlands, or more sophisticated operations, such as the Boolean ap­
proach to multiplying and adding map attributes of different values to determine av­
erages and co-occurrences. GIS provides for the following arithmetic and Boolean op­
erations: 

Arithmetic operations 

0 Addition 

0 Subtraction 

0 Division 

0 Multiplication 

Logical (Boolean) operations (figure 3.1) 

0 Where conditions occur or do not occur together 

0 AND, OR, NOT etc. 

Fig1ure 3. 1. Boolean logic operations 

A •• B 

A.) 
·.B 

\ 

A.-- - ,\B 

A./ -~ . B 

A«•B 
A·J-~\B 

A or B Union 

A not B Clip/erase 

B not A Clip/erase 

A and B Intersect 

(A or B) not (A and B) Union/lntersecVerase 

A or (A and B) Identity 

* This chapter was prepared by A Altobelli, E. Feoli and M. Ghribi, Area of Earth, Environmental 
and Marine Sciences and Techno.ogies, ICS-UNIDO. 

3.1 



3.2 

The raster method has these limitations: 

:J Data storage requirements 

:J Overlay operations are performed on every cell 

CJ Sparse data sets require as much processing as dense ones 

Figure 3.2. Layer 1 (Squares) 

SQUARES-ID S-TYPE 
A Green 
B Blue 

Figure 3.3. Layer 2 (Circles) 

c 

b 
CIRCLES-ID C-TYPE 

a Red 
b Orange 

c Yellow 



Figure 3.4. Overlay logical operation 

······~·········································· 
a 

c 

A 

-

Fig1Jre 3.5. Union (layer 1 or layer 2) 

ll'llON-fD U-TYPE SQUARES-ID 5-TYPE CIRCLES-ID C-TYPE 
2 Light bluE A Green a Red 
4 Sky blue A Green c Yellow 

8 Brown A Green b Orange 

3 Green A Green 
6 Grey B Blue b Orange 

9 Pink B Blue 
1 Red a Red 

5 Yellow c Yellow 

7 Blue b Orange 
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Figure 3.6. Intersect (layer 1 and layer 2) 

4 

INTERSECT-ID I-TYPE SQUARES-ID S-TYPE CIRCLES-ID C-TYPE 
2 Light green A Green a Red 
1 Blue A Green b Orange 

3 Red A Green c Yellow 

4 Yellow B Blue c Yellow 

Figure 3.7. Identity (layer 1 or (layer 1 and layer 2)) 

l~ITY-ID I-TYPE SQUARES-ID S-TYPE CIRCLES-ID C-TYPE 
2 Yellow A Green a Red 

3 Green A Green 
4 Brown A Green c Yellow 

1 Sky blue A Green b Orange 

5 Blue B Blue 

6 Red B Blue c Yellow 
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Figure 3.8. Erase (Layer 1 not Layer 2) 

El~SESQ··ID ESQ-TYPE SQUARES-ID S-TYPE 
1 Green A Green 

2 Blue B Blue 

Figu1·e 3.9. Erase (Layer 2 not Layer 1) 

2 

[ ERASE 
CIRCLE-ID EC-TYPE CIRCLES-ID C-TYPE 

1 Red a Red 

2 Green c Yellow 

3 Blue b Orange 
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3.2. Spatial pattern indices 

3.2. 1. Landscape ecology 

Forman and Godron [1] define landscape as a heterogeneous land area composed of a 
cluster of interacting ecosystems, or elements, that are repeated in a similar form 
throughout. The concept differs from the traditional ecosystem concept in that it fo­
cuses on groups of ecosystems and the interactions among them. Landscape ecology is 
the study of the spatial and temporal aspects of a landscape together with its flora, 
fauna and cultural components. 

Terrestrial landscapes consist of mosaics of individual parcels or patches of dif­
ferent land cover types. In GIS, patches are defined as groups of spatially contiguous 
pixels assigned to the same attribute class. 

Figure 3. 1 O. Example of patch in Tuscany landscape 

Landscape ecology focuses on three characteristics of landscape: structure, func­
tion and change [l ]. Structure applies to the sizes, shapes, numbers and kinds of vari­
ous patches and their arrangement in space (pattern). Function pertains to the interac­
tions between patches of a landscape, that is, the flows of energy, materials and species. 
Change is related to the alterations in the structure and function of a landscape over 
time. Analysis of landscape structure is essential in order to conserve the communities 
and biological and cultural diversity [2]. 

3.2.2. Measures of landscape structure 

The three most commonly used indices when analysing landscape structure are domi­
nance, contagion and fractal dimension. Usually these indices are calculated for a sub­
area of interest from a larger geographic region. These sub-areas can be static (e.g., 
administrative unit, regular grid) or dynamic (moving window). The dominance index 
[3], 0 ~ D ~ 1, is given by: 
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Dominance (D) = Hmax - H 

Where 

H = diversity = - L Pi ln (P) 
Hmax = maximum diversity = ln (n) 
n = number of land classes 
Pi = proportion occupied by class type i 

As D approaches 1.0. the landscape tends to be dominated by a single class type. 
Dominance does not neces:;arily indicate diversity of the landscape [4]. For example, a 
landscape with two types of land cover, each with a 50% proportion, will have the 
same dominance value (D = 0) as one with ten types of land cover, each with a 10% 
proportion. The dominance index does not give a quantitative measurement of land­
scape pattern. 

Example: 

A A A 

A A A 

B B B 

B B B 

A B A 

A A A 

B B B 

A A B 

Hmax = ln (2) = 0.693 
H = -[2 * (8/16) * In (8/16)] = 0.693 
(D) = 0 

A 

A 

B 

B 

B 

A 

B 

B 

The contagion index has been used in ecosystem analysis to quantify the amount 
of clumping or aggregation of patches. It is also used as an indication of the degree of 
fragmentation of a landscape. It has been applied to relate the effects of contagion 
patterns on ecosystem processes such as habitat fragmentation, vegetation dispersal 
and animal movement [5]. 

The contagion index was first proposed by O'Neill et al [3]; Li and Reynolds [5] 
proposed a ratio estimator that is scaled to the interval [0,1] , given by the equation 

Contagion index (C) = 1 - E/ Emax 

Where 

Emax = --L (1 /112) ln (1/ n2
) = 2 In (n) 

n2= number of possible attribute adjacencies 
(For example, if the map has n = 2 attribute classes, then there are four types of 

attribute adjacencies: AA, AB, BA, BB) 

and, 

E = -~: Q; In (0;) 

0,= g,k/ L g,k 
g,k = number of adjacencies Uoins) between pixels of patch types i and k. 
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There are different ways of calculating contagion, for example, the adjacencies 
can be calculated in each of the four cardinal directions. As C approaches 1.0, the 
landscape tends to have larger patches. 

The following example shows a calculation of the contagion index on a matrix 
with 3 land cover types: 

A A A B B 

A A A B B 

A A A B B 

c c c c c 

c c c c c 

Adjacencies 

A B c 

A 24 3 3 

B 3 14 2 

c 3 2 26 

Total adjacencies = 80 

E = -[(24/80) * ln(24/80) + 4 * (3/80) * ln(3/80) + 2 * (2/80) * ln(2/80) 
+ (14/80) * ln(l4/80) + (26/80) * ln(26/80)] = 1.708445 

(C) = 1 - (1.708445/2.197225) = 0.2224533 

3.2.2.1. Patch-per-unit area index 

An alternative landscape index for quantifying landscape fragmentation, known as the 
patch-per-unit area (PPU) index, was proposed by Frohn [4] because there are many 
situations where the contagion index does not measure contagion (an example is pre­
sented below). 
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Patch-per-unit area (PPU) = m / (n *A.) 

Where 
m = total number of patches for a land cover type 
n = total number of pixels in the landscape 
A. = scaling constant equal to the area of a pixel 

Example 

A A A B B 

A A A B B 

A A A B B 

c c c c c 

c c c c c 



A A A B c 

A A A c B 

A A A B c 

B c B c B 

c B c B c 

The first grid contains three attribute classes that are clumped into three patches. 
The second grid contains the same three attribute classes that there are fragmented 
into 1 7 patches. Accordin1~ to the contagion index, the first grid should have a higher 
value than the second because it is more fragmented. However, the value derived by 
the contagion index on the first grid is 0.22 and the value for the second is 0.42. The 
values for PPU, on the other hand, are 0.12 (PPU=3/25) for the first grid and 0.68 
(PPU=l 7 /25) for the second, so this index is more useful. 

3.2.3. Features of fractal figures 

"Fractal" is a general term for figures or phenomena that have no characteristic length, 
are similar and have non-integer dimension. Geometric shapes have characteristic 
length, such as the radius or circumference of a circle and the edge or diagonal of a 
square. Fractal figures are unique in that they cannot be measured with a single char­
acteristic length, because fractal figures hold self-similarity, i.e. their shape does not 
change even when observed under a different scale. This feature is also called scale­
invariance. 

Dimensions are esse1tial in both Euclidean and fractal geometry for representing 
characteristics such as area and perimeter length. For example, when the area of a disk 
(=m..2 = m<I) is calculated, the radius is squared because the disk is a two-dimensional 
set of points (i.e., d =2). A point has a topological dimension of 0, a boundary has a 
dimension of 1, a surface has a dimension of 2, and a solid has a dimension of 3. 

Although the geometrical interpretation of the exponent is often taken for 
granted, the implications of non-integer exponents are at the crux of fractal geometry 
(6]. The fractal dimensior of a linear feature such as a coastline can be any value 
between 1 and 2, depending on its complexity. Similarly, for a surface, the fractal 
dimension value lies between 2 and 3 and reflects the overall characteristics of the 
surface. When applied to remote sensing data the fractal dimension represents the 
complexity of the image. 

3.2.3.1. Dividers (compass) method of measurement 

The dividers (compass) method is used to measure the fractal dimension of a curve, as 
in the length of a coastline on a geographic map. In practice the length of coast on maps 
is measured by moving ;:, set of dividers of fixed length (o) along the coastline. The 
result is that the smaller the o value the longer the coastline, because it is possible to 
measure in greater detail, as shown in the illustration below. The conclusion is that 
total length L

0 
is dependent on the measuring scale (o). For Euclidean objects, L

0 
is 

independent of o; for fractal objects, L
0 

increases as o decreases. Smaller features only 
become apparent at finer scales (self-similar coastline). 
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For fractals, length (L
0
) and measuring scale (o) are related by the power-law: 

Ld= Ko1-vr 

Fractal dimension (Dr) is estimated from the slope of ln(L0) - ln(o) plot: 

In (L
0

) = In (K) + (l-Dr) /no 

Where 

ln(K) is the y-intercept. 

'\ote that the measured length is independent of the measurement scale (De=l) 
for Euclidean (non-fractal) objects. For example, for the British coastline Dr = 1.31, 
while for l'\orway Dr= 1.52. The fractal dimension ( 1:::;; Dr52) in this case quantifies the 
"degree of complexity" of the coastline. 

3.2.3.2. Koch Snowflake curve 

Ideal fractal objects reveal exact copies of themselves with each scale change, which 
was introduced by Helga von Koch. It is "a rough but vigorous model of coastline", in 
::viandelbrot's words. A particularly interesting characteristic of the Koch Snowflake is 
its perimeter. 
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To construct a Koch curve, one begins with a triangle with sides of length 1. At 
the middle of each side, a new triangle one-third the size is added, and so on, as illustra­
ted in the patterns below. The length of the boundary is 3 x 4/3 x 4/3 x 4/3 ... 00• Yet 
the area remains less than the area of the circle drawn around the original triangle. 
Thus an infinite line surrounds a finite area. In the case of the Koch Snowflake the 
curve becomes four-thirds longer than the original curve every times it grows. In this 
case the fractal dimension is 1.26 (ln4/ln3). 

3.2.4. Fractal dimension of a single landscape patch 

The basic relationship between patch area and perimeter as described in Peitgen and 
Saupe [7] is: 

p oo ADf2 

Where 

A = area of th~ patch 
P = perimeter ·Jf the patch 
D = fractal dimension 

When the landscape is grid-based, consisting of square cells, the previous equa­
tion can be modified: 

p = K * ADl2 

Where K is the com.taut of proportionality between area and perimeter, in the 
case of square cells K=4, and the equation is given by 

D = 2 * ln(P / 4)/ ln(A). 

When the landscape contains a patch, which is represented by a single cell, the 
area is equal to one and the equation yields an infinite result. Because a single cell 
represents the simplest shape possible, D = 1.0 by definition. 

3.2.5. Fractal dimer.sion of a landscape 

The calculation of the fractal dimension of landscape involves three steps. First, the 
landscape is divided into contiguous patches of the same attribute class (e.g., land 
cover). Second, the log of the patch perimeter (y) is regressed against the log of the 
patch area (x) for all patchr~s in a landscape. Third, an estimate of the complexity of the 
shape is given by 2.0 timeE the slope (D /2) of regression [8]. Larger values indicate that 
landscape patches have a complex shape. 

3.2. 6. A new landscape index for quantifying 
patch shape complexity 

Frohn [4] proposed a new index for the raster data as an alternative to fractal dimen­
sion, known as "square-pixel" (SqP). This index, which normalizes the ratio of perimeter 
and area to a value between 0 (for squares) and 1 (maximum perimeter deviation from 
that of a perfect square), s given as 

SqP = 1 - (4 * A112/P) 

Where A is the total area of all pixels and P is the total perimeter of all pixels 
in the landscape for a land cover type. 
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3.2. 7. A fractal method to estimate the roughness 
of a remotely sensed image 

When computing fractal dimension, a remotely sensed image is considered a three­
dimensional surface, and its complexity is expressed in terms of its variability over the 
space. Similar to a natural surface, such as hilly terrain or a flat plain, this complexity 
is a function of the vertical variability of pixel values. Hilly terrain has more changes 
in elevation than a flat plain, so it represents a more complex surface. This complexity 
function can be expressed by fractal dimension D and is a quantitative measure of the 
"roughness" of surface [9.J 

One method used for calculating the fractal dimension of an image is the triangu­
lar prism method [10,11]. A window (9 x 9 pixels) is moved over the image, and for 
each pixel the surface area is computed at four different resolutions (squares). 

This method takes elevation values at the centre of pixels located at the corners 
of a square and calculates the average. A vertical line in the square centre pixel takes 
this average as its z value. This creates a prism with four triangular facets. The areas 
of these facets are calculated with a trigonometric formula "Heron's formula" and then 
summed to represent the surface area of this particular square. 

Heron's formula is 

Area= [S * (S-a) * (S-b) * (S-c)] 112 

Where 

S = the semi-perimeter = (a+b+c)/2 
a, b and c are the sides of triangle 

The surface area is calculated within the moving window for four squares size: 1 

per 1, 2 per 2, 4 per 4, and 8 per 8 pixels. 
The logarithm of the total surface areas, which is computed using these different 

measuring resolutions, is plotted against the logarithm of the measuring units (number 
of cells). The fractal dimension (D) is then calculated by performing regression on these 
two variables and imputing the resulting slope of the regression in the equation 

D = 2.0 - B 

Where 

B = the slope of the regression. 

B is expected to be a negative value since the total surface area measured de­
creases with increasing step size; thus the result D should range between 2.0 and 3.0. 

A general trend of D computations is that homogeneous areas yield low estimates 
of D and, as the heterogeneity of the image increases, D also increases. 

The above method is applied to images derived from the Normalized Difference 
Vegetation Index (NDVI) to examine the spatial complexity of the landscape, parti­
cularly green vegetation distribution, while various mathematical combinations of 
satellite bands have been found to be sensitive indicators of the presence and condition 
of green vegetation. i\JDVI is the most commonly used [ 12] and is defined by the equation: 

NDVI = (Nir - Red)/(Nir + Red) 

Where 

Nir = near-infrared band 
Red = red band 

Clouds, water and snow have larger reflectance in the visible band than in the 
near-infrared band, so for these features NDVI is negative. Rock and bare soil have 
similar reflectance in those two bands and result in a vegetation index that is near zero. 
In scenes with vegetation, the NDVI ranges from 0.1 to 0.6; the higher values are 
associated with greater density and greenness of plant canopy. 
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4 IDRISI progrc1m modules* 

This chapter was written using the IDRIS! for windows system. IDRIS! for windows is 
a grid-based geographic in'brmation and image processing system developed by the 
graduate school of geography at Clark University. 

4. 1. Core modules 

The core modules provide basic facilities for the manipulation of raster images. 

4. 1. 1. Data entry 

EDIT 
A simple ASCII text 1~ditor for use in creating a variety of IDRIS! data files. With 

values files, EDIT creates and maintains proper documentation files automatically. 

INITIAL 
Initializes a new image with a constant value. 

INTER CON 
Interpolates a surface from a set of contours by linear interpolation. 

INTERPOL 
Interpolates a surface from point data using either a weighted-distance or poten­

tial surface model. 

LINERAS 
Line-to-Raster conversion. 

POINTRAS 
Performs point-to-raster conversion. 

POLYRAS 
Carries polygon-to-raster conversion. 

TOSCA 
An independent universal digitizing module distributed with IDRIS!. 

UPDATE 
Keyboard entry /update of image data. 

4. 1.2. Attribute data management 

ASSIGN 
Creates an image from an attribute-values file by assigning the data values con­

tained in these files to the cells belonging to defined regions. ASSIGN can also be used 
to reclassify integer irnagei>. 

'The description of IDRIS! program modules included in this chapter was generated by Clark Labs, 
Clark University, Worcester, Ma~;sachusetts, USA: http:/ /www.clarklabs.org/03prod/idrisi.htm 
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DB IDRIS 
Used to import dBase files into IDRIS! value files, and moves IDRIS! value files 

back into dBase format. 

EXTRACT 
Creates an attribute-values file from an image by extracting a summary of data 

values found within defined regions. The summary (minimum, maximum, range, total, 
mean or standard deviation) may also be output as a table. 

4. 1.3. Spatial data management 

CO:\CAT 
Concatenates multiple images to produce a larger image. 

CO'.'\TRACT 
Reduces image resolution by pixel thinning or aggregation. 

EXPA:\D 
Increases image resolution by pixel duplication. 

LI:\EGE:\ 
Generalizes vector lines by point selection, low-pass filtering or tolerance-band 

selection. 

POI'.'\TVEC 
Produces a vector point file from raster image (a companion to POLYVEC). 

POLYVEC 
Performs raster-to-polygon conversion. 

PROJECT 
Undertakes conversions between reference systems for both vector and raster 

files. With raster images, a resampling is undertaken using either a nearest-neighbor or 
bilinear interpolation. Supported projections include the Mercator, Transverse Merca­
tor, Lambert Conformal Conic and Plate Carree. By using reference system parameter 
files, a limitless number of reference system conversions can be undertaken. Full for­
ward and backward transformations are accommodated using ellipsoidal formulas. 
PROJECT also incorporates the United States National Geodetic Survey's NADCON 
procedure for converting between NAD27 and NAD83 and the Molodensky transform 
equations for all other data. Over 200 reference system parameter files are supplied 
with the module, including all State Plane (SPC) systems for NAD27 and NAD83 and 
a complete set of UTM zones based on WGS84 for the northern and southern hemi­
spheres. In addition, users can construct reference system parameter files for any 
system based on a supported projection. 

RASL:\VEC 
Produces plotted-vector output from images. 

RESA\1PLE 
Determines the data values for a rectangular grid by interpolation of the values 

in a different (and possibly warped) grid. Linear, quadratic and cubic mappings be­
tween the grids are provided, along with nearest-neighbor and bilinear interpolations. 
Vector files may also be transformed with this "rubber sheet" procedure. 

SCBSET 
Windows sub-images from groups of images. 

TRA:\SPOS 
Image transposition by row or column reversal, or by rotation. 

WINDOW 
Extracts a rectangular sub-image. 
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4.2. Geographic analysis modules 

4.2. 1. Database quEries 

AREA 
Creates a new image by giving each output pixel the value of the area of the class 

to which the input pixel belonged. Output can also be produced as a table or an at­
tribute values file in a ran~e of measurement units. 

OVERLAY 
Undertakes pixel-wise addition, subtraction, multiplication, division and 

exponentiation of paired images. Maximum, minimum, normalized ratio and cover are 
also supported. On binary images, logical AND/OR operations are supported by 
means of the multiply and maximum operation. Other Boolean operations are sup­
ported through various birary image overlay combinations (see the Boolean logic dia­
gram in chapter 3, figure 3.1). 

PCLASS 
Evaluates the probaJility that pixels exceed or are exceeded by a specified 

threshold using the stated rnot mean square (RMS) error or the data set and a normal 
probability distribution error model. 

PERIM 
Creates a new image 'Jy giving each output pixel the value of the perimeter of the 

class to which the input p xel belongs. Output can also be produced as a table or an 
attribute values file in a range of measurement units. 

QUERY 
Extracts pixels designated by an independent mask into a sequential file for 

subsequent statistical analysis. 

RECLASS 
Reclassifies pixels by equal intervals or user-defined schemes. RECLASS is com­

monly used as a database query routine by reclassifying images into Boolean maps of 
areas meeting the specified conditions. 

4.2.2. Map algebra 

SCALAR 
Adds, subtracts, multiplies, divides and exponentiates pixels by a constant value. 

TRANSFOR 
Transforms the attributes of images such as log transformation, using any of 14 

operations. 

4.2.3. Distance operators 

ALLOCATE 
Performs spatial allocation using either DISTANCE or COST surfaces. 

COST 
Generates a distance,/proximity surface where distance is measured as the least 

distance in moving over a friction surface. 

DECO MP 
Decomposes a force vector (as a magnitude and direction image pair) into x and 

y component images. Also takes x and y component images and produces a force­
vector image pair. 
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DISTA:\CE 
Calculates the distance/proximity of each pixel to the nearest of a set of target 

pixels. 

DISPERSE 
DISPERSE is a companion to VARCOST that calculates dispersion distances. The 

procedure is essentially the same as that of VARCOST except that the emphasis is on 
forces acting to disperse a body (e.g., a point-source contaminant spill) and the time 
taken to disperse it to a specified distance. DISPERSE is released as an experimental 
module in IDRIS! and all users are invited to comment on their experiences with this 
procedure and provide suggestions for modifications. 

PATHWAY 
Finds the shortest path between one or more specified points and a destination 

specified as the lowest point on a COST surface. 

RESLLTA:\' 
Computes the resultant force vector (as a magnitude and direction image pair) 

from two input force-vector /image pairs. 

SPDIST 
A companion to the DISTANCE module, SPDIST calculates spherical distances 

on the surface of the earth from designated features using spherical trigonometry. 

THIESSE:\ 
Produces Thiessen polygons (a Voronoi tessellation) about a set of irregularly 

distributed points. 

VARCOST 
This module is the equivalent of COST (specifically the COSTPUSH algorithm) 

except that it recognizes that frictions may have different strengths in different direc­
tions. Frictions are entered as force vectors described by a pair of images, a magnitude 
image and a direction image. VAR COST also allows the specification of an isotropic 
friction image for omni-directional elements. 

4.2.4. Context operators 

GROUP 
Classifies pixels according to contiguous groups. 

H:\'TRLAND 
Determines the supply areas dominated by, or the hinterlands of, point demand 

centres. 

SLRFACE 
Produces slope gradient and aspect images from a surface. Can also be used to 

create analytical hill shading. 

VIEW SHED 
Creates an image of all points visible from one or more viewpoints over a given 

surface. 

WATRSHED 
Determines the watersheds of one or more specified locations. 
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4.3. Decisio111 supp~rt analysis modules 

BAYES 
Evaluates Bayes' theorem. Multiple evidence maps (such as that produced by 

PCLASS) are permitted as long as they are conditionally independent. Prior probabili­
ties may be input in map form (and thus, like the evidence maps, may vary continu­
ously over space). The user is also able to specify the confidence in the decision rule, 
i.e., the belief that the evidence supportive of the hypothesis is truly reflected in the 
evidence at hand, p(ele). Bayes is an extension to what is sometimes called a Bayesian 
Weight of Evidence approach. 

ERRMAT 
Produces an error matrix analysis of categorical map data compared to ground 

truth information. Tabulates error of omission and commission, marginal and total 
errors and selected confidence intervals. Per category Kappa Index of Agreement 
figures are also provided. This module is a substantial revision and replacement for 
CONFUSE. 

FUZZY 
Evaluates the fuzzy ~:et membership values (possibilities) of data cells based on 

any of three membership functions: sigmoid, j-shaped and linear. Monotonically in­
creasing, monotonically decreasing, symmetric and asymmetric variants are supported. 
Other fuzzy set operations such as CON (concentration), DIL (dilution), AND and OR 
are covered by the standard modules TRANSFOR and OVERLAY. 

MCE 
Computes a multi-criteria evaluation by means of weighted linear combination of 

factors, subsequently masked by a set of constraints. Factor uncertainty information is 
propagated to the result to compute the uncertainty in the suitability derived. 

MDCHOICE 
MDCHOICE is a multi-dimensional choice procedure that produces an output 

map indicating, for each cell, which of a series of input maps has the highest value. In 
cases where the input mapE represent suitability for different objectives, the procedure 
provides one alternative to the multi-objective decision problem (although the MOLA 
procedure is preferable in most instances). In these cases, input maps should be stand­
ardized either with STANDARD or by means of the histogram equalization procedure 
in STRETCH. 

MOLA 
An iterative multi-objective land allocation routine. Input maps are ranked suit­

ability maps such as would be produced by ranking (using RANK) the output from a 
multi-criteria evaluation (u:;ing MCE). The procedure uses a decision heuristic to re­
solve conflicts and is suitable for use with massive data sets. 

RANK 
Orders the cells in a raster image. Ties may optionally be resolved by using the 

rank order of a second image. Both primary and secondary ranks may be in ascending 
or descending order. The procedure is used extensively in optimization problems such as 
with RECLASS for single objective decisions and MOLA for multi-objective decisions. 

STANDARD 
Converts an image to standard scores. 

WEIGHT 
Computes a best-fit set of weights by calculation of the principal eigenconvector 

of a pairwise reciprocal ccrnparison matrix in which each factor in a multi-criteria 
evaluation is compared to every other factor. Information on consensus and proce­
dures for resolving lack of consensus are provided. 

4.5 



5 
ArcVie~w program modules 
ESR/-ArcView user guide 



5 ArcView prO!tJram modules* 

ArcView is a product of the Environmental Systems Research Institute (ESRI). It is a 
desktop geographic information system for accessing, displaying, querying, analysing, 
and publishing data. It links traditional data analysis tools, such as spreadsheets and 
graphics, with maps for a completely integrated analysis system. 

5. 1. ArcView tenninology 

5. 1. 1. Project 

A project is the file in which ArcView stores work. All related work can be stored in 
a single project, including tables, charts, spatial views of data, map layouts etc. A 
project is saved with an (*.apr) file extension. Thus, the file "tunis.apr" would store all 
material, such as maps anc tables, related to that project. Each project has a window. 

5.1.2. Project windcw 

The project window is the small window to the left of the initial ArcView window. 
When ArcView is first op1~ned, the title of the project window is "Untitled." After a 
project is saved, this window contains the project file's name (with an .apr extension). 
It lists all the components of the project, organized by type (Views, Tables, Charts etc.). 
This window can be used to add new components to a project or to open existing ones. 

5. 1.3. Table 

A table is a data file that contains rows of information about items in a particular 

geographic category (such 1s hotels, cities, streets, counties, countries etc.), with each 
row representing a different item. Tables also have numerous columns, with each col­
umn representing a particular attribute (variable); for example, one column might rep­
resent pesticide used, another population size etc. 

5.1.4. Theme 

Theme is the ArcView term for map layer that contains both spatial and attribute data 
(the latter are in database tables). A theme is a file containing the graphic information 
required for drawing a set of geographic features together with information about 
those features. Themes are listed on the left side of the view window in the table of 
contents along with the legends that identify them on the map. Examples of themes are 
streets, buildings, cities, rivers, countries and railroads. Themes can cover geographic 
phenomena at any scale, from small gardens to the entire planet. 

'The descriptions of ArcView program modules included in this chapter were generated by ESRI­
ArcView user guide; http:/ /ww"v.esri.com/software/arcview / 
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5. 7.5. View 

A view is the interactive map used to display queries and to analyse data in Arc View. 
Several map layers, called "themes", are normally displayed in a single view. There can 
be more than one view in a project. The name of each view will be listed in the project 
window. 

5.2. Spatial Analyst 

The ArcView Spatial Analyst evaluates spatial relationships in the data and provides 
functions ranging from viewing and querying data to creating an integrated custom 
application. It includes tools for single-layer raster analysis that can generate surfaces, 
analyse characteristics such as slop, or model drainage basins. There are also interac­
tive tools for creating contours and histograms. 

ArcView Spatial Analyst provides tools to do the following: 

::J Convert feature themes (point, line or polygon) to grid themes 

::J Create raster buffers based on distance or proximity from feature or grid 
themes 

::J Generate density maps from themes containing point features 

::J Create continuous surfaces from scattered point features 

::J Provide contour, slop and aspect maps and hill shades of these surfaces 

0 Conduct cell-based map analysis 

0 Perform Boolean queries and algebraic calculations on multiple-grid themes 
simultaneously 

0 Carry out neighbourhood and zone analysis 

0 Produce grid classification and displays 

Cnique to ArcView Spatial Analyst is the ability to work with raster-based data 
(including the ability to overlay, query and display multiple raster themes) as well as 
to conduct integrated raster-vector theme analysis. An example would be the aggrega­
tion of properties of a raster theme based on an overlaid vector theme. 

ArcView Spatial Analyst is particularly well-suited to problems that require 
distance or other continuous surface modelling information to be considered as part of 
the analysis. For example, site suitability analysis often requires the combination of 
information about slope (information best represented as raster data) and the location 
of roads and property boundaries (information best represented as vector data) to 
arrive at the best location for a new facility. The Arc View Spatial Analyst can not only 
generate the appropriate surface representation of information from a variety of exist­
ing data sources, but it can also derive new information from the overlay of multiple 
theme types. 

5.3. Network Analyst 

The Arc View :\'etwork Analyst enables users to solve a variety of problems relating 
to geographic networks (i.e., streets, highways, rivers, pipelines, electric lines etc.) such 
as finding the most efficient travel route, generating travel directions, finding the clos­
est facility or defining service areas based on travel time. 
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ArcView Network Analyst adds an integrated graphical user interface, which 
provides access to network modelling capabilities that will assist the user to perform 
the following tasks: 

0 To find the most direct path between two points 

0 To establish thi~ optimum route between many points 

0 To locate the closest facility 

0 To conduct time series analysis 

ArcView Network Analyst can also do point-to-point routing (known as mid-arc 
routing, as opposed to endJoint-to-endpoint routing) and can reference local landmarks 
when reporting route directions. The geographic network data can be based on Arc/ 
Info coverage, shape files or computer-aided designs (CAD). 

The Arc View Network Analyst also includes a suite of more advanced network 
analysis tools that can be accessed through Avenue software. Developers will be able 
to deliver very sophistica;ed network analysis applications based on these extended 
capabilities. 

5.4. 30 Anal~st 

The Arc View 3D Analyst software provides two types of surface models and grids for 
modelling continuous data like terrain elevation or temperature gradient. The main 
operational modules are capable of: 

0 Creating and nodifying surface models 

0 Creating three dimensional file themes 

0 Simple editing of triangulated irregular networks (TINs) 

0 Planimetric dbplay of surfaces 

Unique features of Arc View 3D Analyst include support for triangulated irregu­
lar networks (TINs) and simple three-dimensional vector geometry, as well as interac­
tive perspective viewing. 
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6 Getting started with IDRISI* 

IDRISI for Windows consists of a main interface program (with a menu and toolbar 
system) and a collection of over 150 program modules that provide facilities for the 
input, display and analysis of geographic and remotely sensed data. These geographic 
data are described in the form of map layers. 

6. 1. Start IDRISI 

From the Desktop, double-dick on the IDRISI GIS Software Version 2 shortcut to start 
the program. After the start-up process, the application window appears (figure 6.1). 

FigurE~ 6. 1. Application window for IDRISI 

As soon as you star: creating or using your own project, you should establish a 
working directory (figures 6.2 and 6.3). From the menu bar, choose Environment, and 
then ENVIRON. 

The Operating Environment dialogue box will appear. Directories are shown on 
the right. Move to the c:\ics\ghribi directory by double-clicking each folder succes­
sively. 

To open an existing project, click on Display in the menu bar and choose DIS­
PLAY Launcher (figure E.4). 

'This chapter was prepared by M. Ghribi, Area of Earth, Environmental and Marine Sciences and 
Technologies, ICS-UNIDO. 
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Figure 6.2. Environment menu in IDRISI 

Figure 6.3. Establishing a working directory for projects 

ENVIRON - Operating Envi1onment 13 

Figure 6.4. Opening an existing project with display launcher 
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6.2. Open a1t1 existing raster file and overlay vector files 

In the Display Map Composition Launcher dialogue box, double-click on the input 
image file box and choose AREA. Select the IDRISI palette file QUAL16 and click the 
map components boxes to add the Title, Legend, Logo etc. To display the raster map 
layer click OK in the icon field (figure 6.5). 

Figure 6.5. Opening a raster map layers 

Once the raster map layer is displayed, go to the Composer dialogue box and 
press the Add Layer icon to add vector map layers. Double-click on the input file 
window and choose Area V; accept the default symbol file. This will provide the admin­
istrative borders of the provinces of the study area used in this example (figure 6.6). 

Figure 6.6. Use of composer dialogue box to add vector map layers 
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To add other components of your map, click Properties and press Modify map 
components in the Composer dialogue box and click on the component(s) you wish to 
modify. For each item selected, click the visible window and press OK (figure 6.7). 

Figure 6.7. Modifying components of a raster map 
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Once you have finished selecting all map components, go to the Composer dia· 
logue box, select Save composition, then Save composition as MAP File and give a 
file name to your final map composition (figure 6.8). 

Figure 6.8. Saving final raster map composition 

1lename: 
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6.3. Exercise 1: D1e1ta extraction from the Internet 

6.3. 7. Purpose 

This exercise emphasizes the utilities of the Worldwide Web as a source for data. It 
explains the steps involved in selecting the desired data with respect to a geographic 
system, and how to impo.~t it to GIS software. 

6.3.2. Procedure 

Using the Web navigator, access the following URL site: 

http://edcwww.cr.usgs.gov/landdaac/ 1 KM/ comp 1 Od.html 

Select the following criteria for this exercise: 

10-day composite period: April 1-10, 1992 
Resolution: 1 km 

Latitude /Longitude geographic coordinates: 
Northernmost Latitude: 38 
Westernmost Longitude: 9 
Southernmost Latitude: 36 
Easternmost Longitude: 11 

Bands to be rdrieved: NDVl 

Press the Retrieve data icon, and the research is launched. The output gives the 
size of the extracted image, specifying the number of lines (rows) and samples (col­
umns). 

Select Retrileve data again and the data will be downloaded. 
Choose the directory corresponding with your IDRISI environment, in which you 

will save the downloaded data. Rename the image with an extension .img (for example, 
extract.img), in order to prepare its importation to IDRISI. 

NOAA- AVHRR 10-day composite image, 1-km-Resolution. 

Image size: 384 lines by 384 samples, 8-bit pixels 

Actual coordinates: 

Northernmost Latitude: 38.859705, line 4353 
Southernmost Latitude: 35.415302, line 4736 
Westernmost Longitude: 7.192014, sample 21377 
Easternmost Longitude: 12.433991, sample 21760 

Band: 6 ... NDVI 

Run the IDRIS! program and set up the environment (figure 6.2), which contains 
extract.img. Select File>Document (figure 6.9), double-click on the Input file window 
and select "extract.img". Fill in the document file with the corresponding properties of 
the extracted image. You can now display the image. 

To view the extracsed image, complete the document file according to the crite­
rion corresponding to ycur study area (figure 6.10). 
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Figure 6.9. File document IDRISI window 

Figure 6. 1 O. Document of the extracted image 

oocoMENT - EXTRACT , m 
Tide'.: 

6.3.3. Study area extraction 

To illustrate IDRISI's windowing and geographic selection capabilities, this exercise 
shows how to selectively modify downloaded data in order to keep only the zone of 
interest. 

To select the frame in which your study area is located, select Reformat> 
WINDOW. Specify the geographic coordinates (for example in this case latitude/lon­
gitude) and press OK (figure 6.11 and 6.12). 
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Figure 6. 11.. Extract a sub-image from a large image 

Figure 6.12. Image windowing 

To select the irregular area of interest within the frame, choose Analysis> 
Database query>RECLASS (figure 6.13). 

Double-dick on the Input file window and select the raster file area; enter the 
output file name arear. Go to Assign a new value of and assign a new value 1 to all 
values from 1 to just less than 8 (figure 6.14). 

Select Analysis>Database Query>OVERLAY (figure 6.15), Insert arear.img 
as a first image and extract.img as a second image. Choose the overlay option 
First * Second; choose the output file name NDVI. Enter a title for the overlay image 
(figure 6.16). 
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Figure 6. 13. RECLASS IDRISI module window 

Figure 6. 14. Area reclassification 

Figure 6.15. OVERLAY IDRISI module window 
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Figure 6. 16. NOVI image extraction using OVERLAY IORISI module 

Click OK to see the final image overlay (figure 6.17). 

Figure 6.17. NOVI final image 

6.4. Exercisf~ 2: lmiage processing 

6.4. 7. Purpose 

This exercise will enable che participant to manipulate several mathematical expres­
sions provided by the IDRIS! software. In the following example, the average normal­
ized difference vegetation index (NDVI) is calculated. 
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6.4.2. Procedure 

Select Analysis>Mathematical operators>Image calculator (figure 6.18). In the Ex­
pression to process (figure 6.19), press Insert image, choose 10AV920V, and add the 
+ sign, select Insert image again, insert 20AV920V and +; repeat the process and 
insert 30AV920V. Put the whole expression between parentheses, and divide by 3 to 
find the :\DVI average of April 1992. Rename the output file Avgl 992, and press 
Process expression to produce the final image (figure 6.20). 

Figure 6. 18. Image calculator IDRISI module window 

Figure 6. 19. Average NOVI image using IDRISI image calculator 

Output file nauie : 

1Avg1992 

The average NDVI of April 1992 is calculated using the 10 day-average of 1-10 
April 1992 (10AV920V), the 10 day-average of 11-20 April (20AV920V) and the 10 
day-average of 21-30 April 1992 (30AV920V). 
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Figure 6.:20. Average NDVI image of April 1992 

6.5. Exercise~ 3: Time-series analysis 

6. 5. 1. Purpose 

To measure the global changes over profiles of time, the vegetation dynamics of the 
Governorate of Ariana for the whole area by each industrial site was measured taking 

the normalized difference vegetation index (NOVI) as the numerical indicator. 

6.5.2. Procedure 

First, a time-series file is created where the files that will undergo a time-series analysis 
are treated in chronological order. 

Select Data Entry>Edit, click time series file, choose the file name NDVI-MOD 
and click OK (figure 6.21 ). 

Select avgl992, avgl993 and avgl995 then press Add (figure 6.22). 
Go to Analysis>Change>Time-series>Profile and click on the option Over time 

series. Maintain the default summary type Mean. Select the Save as values file and 
insert profile as the prefix for value files. 

Insert AREATOT as the image defining the sample spots. Type AVGNDVI as the 
time series file to be taken into account when computing the NOVI change throughout 
the whole area and click OK (figure 6.23 and 6.24). 
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Figure 6.21. Edit file IDRISI module window 

Figure 6.22. Editing time series file NOVI-MOD 
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Figure 6.23. PROFILE IDRISI module window 
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Figure 6.2.i. The NDVI change from 1992 to 1995 
for the entire Govemorate of Ariana 

Temporal profile drawn from AVGNDVI 
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6.6. Exercise 4: Lim~ar regression 

6. 6. 1. Purpose 

To demonstrate statistical function of the software, this exercise uses simple and multi­
linear regressions to deternine the correlation of NDVI, industrial manpower and 
rainfall. 

6. 6.2. Procedure for simple linear regression 

Select Analysis>Statistics>Regress. Enter the image file name LNNDVI as the de­
pendent variable and the inage file name LNLABOUR as the independent variable 
and press OK to carry out the regression analysis (figures 6.25 and 6.26). 

1=igure 6.25. Simple linear regression analysis 
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Figure 6.26. Simple linear regression analysis curve, where X is the natural 
logarithm of the number of employees (labour) and Y is the natural logarithm 

of the average normalized difference vegetation index (NOVI) 

S.2190 
Y = 76.160164 -13.8305B9 X r = -0 7563 

B.8274 

S.4353 
coeff of det (12) = 57 .W 1, 

$.0442 s.d. of X (Sx) = 0.07132'.'3 

s.d. ol Y (Sy) = 1.3042401 

7.2610 s.e. of estim3te = 0.S03:214B 

s.e. of beta = 2.74441$1 
6.889:4 

t stat for r or beta = -5.039526.5 

8.4778 t stat forbetao1 = -5.403903-0 

:::: 21 

apparent df 

5.3030 

48480 4.3700 4.3920 4.9140 4.9380 4.95SO 4.9300 5.0020 5.0240 5.041JO 5.0630 

6. 6.3. Interpretation 

To establish a statistical correlation between the industrial development and the NDVI 
change, the :\'DVI average values were extracted and the number of employees was 
calculated for each province of the Governorate of Ariana (7 main residential sites) and 
for the same period (April 1992, April 1993 and April 1995). This gives 2 different 
matrices for each variable (NDVI and Labour) containing 21 samples (n=21) repre­
sented by the green boxes in the figure 6.26. 

The simple linear regression equation is: 

Ln(NDVI) = 76.160164-13.830569 [Ln(Labour)] 

There is a negative correlation between the NDVI and the number of employees, 
as shown by the equation above with a coefficient of correlation r2 = 0.572. 

The increase of industrial activities occurs with an increase in the number of 
industrial plants. This, in turn, leads to the establishment of urban settlements. As a 
result the biomass and productivity of the green cover diminishes. Based on the direct 
and indirect effects of industry, NDVI will automatically decline. 

6.7. Exercise 5: Multi-linear regression 

6. 7. 1. Purpose 

In this exercise a multi-linear regression is conducted where NDVI is the dependent 
factor and labour and rainfall are independent factors. A square-root transformation 
has already been done for rainfall to bring its values to the same numerical range of 
Ln(:\TDVI) and Ln(Labour). 

6. 7.2. Procedure 

Select Analysis>Statistics>MULTIREG. As a dependent variable, enter LnNDVI, 
select LNLABOUR (labour) and sqrt (rainfall) as independent variables. Choose pred 
as an output prediction file and res as an output residual file (figure 6.27). 
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Figure 6.27. Multi-regression IDRISI module window 

6. 7.3. Results and interpretations 

Regression equation: 

Ln(NDVI) = 5. l066 - 0.0366 [Ln(Labour)] + 0.0183 [SQRT(Rainfall)] 

Regression statistics: 
Apparent R = 0.805019 Apparent R square= 0.648056 
Adjusted R = 0.793431 Adjusted R square= 0.629533 

F (2, 18) = 16.572279 

Analysis of variance (ANOVA) regression table 

Apparent degrees Sum of 
Source of freedom squares 

Regression 2 0.07 
Residential 18 0.04 
Total 20 0.11 

Individual regression coefficients 

Intercept 
Labour 
rainfall 

Coefficient 

5.106647 
-0.036593 

0.018338 

Mean square 

t_test (18) 

0.03 
0.00 

49.169075 
-4.562873 

1.971741 
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According to the regression equation, NDVI is more negatively correlated with 
industry than positively correlated with rainfall. 

F (2, 18) statistical =3.55 
F (2, 18) calculated =16.572 
F ( 2' 18) statistical < F ( 2' 18) calculated 

Hence the regression model between NDVI as an independent factor, and both 
industrial manpower and rainfall is very significant. 

For the partial correlation, the student test t 18 theoretical is equal to 2.101. At the 
level of 5% confidence it is greater than t~test (18) = -4.562873, which means that the 
industry is significantly correlated with NDVI, whereas rainfall is not statistically 
correlated with NDVI. 

In conclusion, the NDVI is positively correlated with rainfall and negatively cor­
related with industrial manpower. In fact, the rain affects green biomass cover depend­
ing on the season and the bio-climatic level. On the other hand, industrial manpower 
has both a direct and an indirect negative influence on the vegetation cover. Its direct 
effect is shown in the establishment of factories to the detriment of the green cover. Its 
indirect effect is due to rural migration by those seeking employment, resulting in the 
establishment of new urban settlements. 

6.16 



7 
Getting ~;tarted with ArcView 
M. Fernetti and M. Dragan 



7 Getting start1ed with ArcView* 

This chapter contains some exercises using ArcView GIS (a leading desktop geographic 
information system software). It includes data input and integration, land use destina­
tion using global positioning system (GPS) data, geo-referencing raster images and per­
forming spatial analysis. 

7. 1. Step 1: Start 'lrcView 

From the Desktop, double-dick on the ArcView GIS Version 3.0a shortcut to start the 
program. 

After the start-up process, you are presented with the application window that 
contains an untitled window, which in ArcView is referred to as the "project window" 
(figure 7.1 ). 

Figure 7. 1. ArcView projed window 

As soon as you begin to create your own project, the Project window will list all 
the documents (including views, tables, charts, layouts and scripts) that are included in 
the project. 

'This chapter was prepared by M. Fernetti and M. Dragan, Area of Earth, Environmental and Marine 
Sciences and Technologies, ICS-UNIDO. 
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7.2. Step 2: Open an existing proiect and display views 
and tables 

From the File menu, choose Open Project. 

~Tools ~indow 

[lose Project 

.S.ave Project 

Save Project 8s ... 

Extensions ... 

Ctrl+S 

Browse Sample E :-:tensions ... 

E.~it 

The Open Project dialogue box appears. The directories are shown on the right. 
The Arc View project files within each directory are shown on the left. On the right 
side of the pop-up window is the Directories list. Move to the c:\icstrn\ 
arcview\ex_l directory by double-clicking each folder successively (figure 7.2). 

Figure 7.2. ArcView window for opening a project 

To open the project, click on ex_l.apr in the File Name list, and then click OK. 
When the project opens you will see the Project window containing two views, named 
Africa Map and World Map. Double-click the view named World Map to open it. 

The view opens with a map of the world that we will modify later in the exercise. 
We will now have a closer look at the African continent. First, close the World Map 
window by selecting Close from the File menu. From the project window, click on 
Africa Map and choose Open. The view opens (figure 7.3.) 
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Figure 7.3. Projed view window 

7.2. 1. Theme operations 

7.2.1.1. Turning themes on and off 

In order to display a theme in the view dialogue box you must click on its check box. 

When a theme is turned on, ArcView draws it in the map display area. When a 
theme is turned off, Arc View does not draw the theme. Turning the theme off affects 
the display only, it does net delete the feature from the theme. A theme does not have 
to be turned on to perform operations on it. 

7.2.1.2. Making a theme active 

To make a theme active click on its name in the table of contents When a theme is 
active, it is highlighted in the table of contents, which means that it is available to 
perform operations (figure 7.4). Many operations only work on active themes. 

7 .2.1.3. Display order 

Arc View draws the themes sequentially from the bottom of the table of contents. To 
change the order in which a theme is drawn, place the cursor over the theme, hold 
down the mouse button and drag the theme to a new position (up or down) in the table 
of contents. 

Notice that in figure 7.4 the Lakes and Countries themes are checked in the table 
of contents and are visible in the view while Deg30, rivers and main cities are not 
checked. Click on the check box by the Deg30 theme to turn the theme on. Then click 
on the check box to display the Rivers theme. 
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Figure 7.4. Activating a theme in the table of contents 

Theme turned on 

i 
Table of 
contents 

The theme is displayed in the view, but it is immediately obscured by the Lakes 
and Countries themes. A line or point theme must be on top of a polygon theme in the 
table of contents in order to be visible. In the table of contents, place the cursor on the 
Rivers theme. Click and drag the theme to the top of the table of contents and release 
the mouse button. 

The display order changes and all the themes are now visible. Repeat the same 
procedure for the point theme representing Main cities after clicking on its check box. 

Change the display order and turn the themes on and off to become familiar with 
the theme display. Determine the correct sequence of themes in order to see all the 
features. 

Figure 7.5. View dialogue box showing different features 
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7.3. Step 3: Navination basics in the view dialogue box 

ArcView provides tools to zoom in and out, while in the view dialogue box. The view 
toolbar has the following options: 

With these Zoom in and Zoom out buttons the display is zoomed in or out by 
a factor of two, centered en the original display. Zoom to Previous allows the view to 
be redrawn to its previou.s extent. 

These buttons are in the view tool bar: 

The two zoom buttons on the left give more control over the extent of the 
zoomed area. 

Click on the Zoom In button to make it active. 

Click and drag to dnw a rectangle in the view, and release the mouse button. The 
view redraws to the extent of the selected area. 

To focus on another part of the theme, shift the view with the Pan tool. 

Click on a point in view and drag the cursor to focus on another area. Experiment 
with these buttons to get familiar with the zooming options. 

When you have finished, make Countries the active theme by clicking on its 
check box. 

Click on the Zoom to Active Theme(s) button. 

7.4. Step 4:: Get i111formation about features 

Once you are familiar with the zoom and pan tools, zoom the east African region, 
where we will retrieve information about the features. 

Verify that the Main cities theme is the active by clicking on its name in the table 
of contents. 

Click the Idlentify tool. 

The cursor changes to cross hairs. Click on any city to identify it. The Identify 
Results dialogue box appears which displays the information taken from the attribute 
table of the Main cities tLeme (figure 7.6). Click on another city to experiment further. 
To complete this experience, close the Identify Results window. 
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Figure 7.6. View dialogue box showing the attribute table 

Another way to get information about features is to select them in the view and 
then examine their records in the theme table. When you select a feature in view, you 
also select the corresponding record in the Theme Attributes table. There are several 
ways to select features in view. One quick way is to use the Find button. 

In the view of table of contents, click on the Countries theme to activate it. Select 
Find in the menu bar. 

In the Attributes dialogue box, which is displayed in the Find Text box, type 
Guinea and click OK. ArcView searches for the attribute in the table and when a 
match is found the feature is highlighted and centered in the view. 

In order to get back to east Africa, click the Zoom to Previous button. 

Another way to select features, which allows multiple selections, is the Select 
Feature tool. Click on the button in the toolbar in order to make it active. 

Put the cursor anywhere in view, then click and drag to make a rectangle. When 
you release the mouse button, any countries that are included wholly or partially in the 
rectangle will be selected in view. 

7.5. Step 5: Working with tables 

Having selected certain features, it is now possible to look at their attributes. Open the 
attribute theme table for the Countries theme. Click the Open Theme Table button. 
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Figure 7.7. View dialogue box showing the way to select features 

The Attributes of Countries theme table is displayed (figure 7.8). The records 
highlighted in yellow match the selected features in view. It is probably necessary to 
use the side scroll bar to move around the table to see all the selected records. To see 
all the selected records together click the Promote button. 

The selected records move to the top of the table. The scroll bar at the bottom of 
the table allows you to see all the remaining fields. 

Fi!~ure 7.8. Selection of attributes 
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Click Select None in the tool bar to unselect all the selected records in the table 
as well as the related features in view. 

Another common operation is sorting the table according to the values of a cer­
tain field. 

For example, you might want to sort the countries in order of projected popula­
tion, from the largest to the smallest. From the Attributes of Countries table, click on 
the Projected Population field name to highlight it, then click the Sort Descending 
button. 

Highlight another field sort in ascending order. 

Sorting works on both numerical and alphabetical fields and the result is kept 
only while the table is open. When you close the table the order is restored according 
to the internal indexing system adopted by the program. Sorting is useful for visuali­
zation purposes and does not change the original structure of the table. When you have 
finished experimenting, close the theme attributes table. 

To see the entire map of Africa, with the view window active, click on the Zoom 
to Active Theme(s) button. 

7.6. Step 6: Querying data 

In Step 4, we used the Find button to select a feature according to its attribute value 
(for example, the name of a country). This approach allows you to select only one 
feature for each search. Another powerful tool is the Query Builder icon. It allows you 
to select more than one feature at a time based on a logical expression (logical query). 
\1ake Countries the active theme. From the toolbar, click on the Query builder icon. 

The Query Builder dialogue window (figure 7.9) lists the fields in the theme's 
attribute table (countries, in this case) on the left. In the lower part of the window, you 
can build a logical expression by either clicking on fields, operators and values or 
simply by typing it in. For this exercise select all the countries according to life expect­
ancy. 

From the Fields list, double-click the Life expectancy field to enter [Life_exp] 
into the expression. From the Operators field, click ">" (greater than). 

From the Values field, scroll down the list and select one of the available values 
by double-clicking it. As you can see, the choice is from a range of decimal figures. 

To execute the expression, click New Set. ArcView executes the query, and fea­
tures that match the criteria are highlighted on your map. Close the dialogue window 
to see the results more clearly. 

Repeat the selection in order to specify an integer value of your choice. For 
example, build a query to select all the countries with life expectancy that is greater 
than 55 years. 

Start the Query Builder and type the following expression: 

([Life_exp] > 55 ) 
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Figure 7.9. Query builder dialogue window 
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To execute the expression click New Set. This operation unselects the previously 
selected features to let the query work on the whole new data set. The result is shown 
in figure 7.10. 

Figure 7. 1 O. View dialogue box showing life expectancy distribution 

,/; Main c~s 

• 
~ Rivers 

/\ / ,' v· 

,{.i' Cc,.uak(fM 

ED 
~ D~930.o/lp 

GJ 

To see the life expectancy values for each selected country, you can either use the 
Identify tool in the view and click over the countries, 

or click Open Theme Table and use the Promote button. 
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Once you have finished, return to the Africa Map view and click Clear Selected 
Features to unselect all the features. 

7.7. Step 7: Refining your query 

In Step 6 you used ArcView Query Builder to select a set of features in a theme on 
your map. You can also use the Query Builder to refine a set of features with any of 
the selection methods available in ArcView. Query Builder can widen your selection 
and add the features specified in your query expression to an existing set of selected 
features (Add to Set option), or apply the query expression only to those features that 
have already been selected (Select from Set option). This exercise uses the latter 
option. 

First, we will use the Select feature tool in the view to create a subset of fea­
tures. Click on Select Feature button and select all the countries in the southern 
African region. 

Click on the Query Builder button again. In the Query Builder dialogue box, 
build an expression selecting those countries with a projected population that is less 
than or equal to 2,000,000: 

([Projected population] <= 2000000) 

In order to apply this query only to the countries you have previously selected, 
click on the Select from Set button. In your map, only three countries will remain 
highlighted: Namibia, Botswana and Swaziland. To look more closely at the selected 
polygons, use the Zoom In button (figure 7.11). 

Figure 7. 11. Select and unselect features 
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Once you have finished, return to the Africa Map view and click on the Clear 
Selected Features button to unselect all the features. 
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7.8. Step 8: Getting data into ArcView 

So far, you have worked with the view already containing the feature themes. You can 
add more themes to a view and save the modified project for future use. In this exercise 
you will add a point theme representing the major cities in the world and a line theme 
representing the main rivers. 

First, close the Africa Map view. 
Double-click on the World Map view to open it. 
Click on the Add Theme button to add a theme to the view. 

The Add Theme dialogue box is displayed. The directories appear in the scrolling 
list on the right and spatial data sources are in the scrolling list on the left. 

Navigate to c:\icstrn \arcview\ex_l \world. 
On the left side, you can see all the Feature Data Source files that are available. 

Click on Lakes.shp to highlight it. Click OK. 
ArcView adds shapefile as a theme. In the view's table of contents, click on the 

Lakes.shp and click the check box to draw the theme. 
Repeat the same steps to add two more themes. 
Click the Add Theme button and select Cities.shp. Click OK. Then click on its 

check box to draw in this theme. Repeat the same procedure to add the Rivers.shp 
theme. Change the order of the themes to make them all visible in the view. 

When you add a theme to a view, ArcView assigns a randomly selected colour 
to all features. If you want to change the default colour, you can use the Legend Editor 
(figure 7.12). To open the Legend Editor, double-click on the Lakes.shp theme in the 
Table of Contents. The Leg•end Editor is displayed. 

Figure 7.12. Legend editor window for changing symbol properties 
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To change the Symbol properties for the Lakes theme, double-dick on the Symbol 
rectangle. The Fill Palette is displayed. With this tool you can change the colour, fill 
pattern, font style, line symbol and point symbol used to represent the features in the 
view. 

Figure 7. 13. Fill palette window for changing colour palette 
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Click the Colour Palette button at the top of the Fill Palette box (figure 7.13) to 
switch to the Colour Palette. 

Choose an appropriate colour to represent the Lakes in your map by clicking on 
the colour; close the Colour Palette. To apply your changes click Apply in the Legend 
Editor and close it. ArcView redraws the theme according to the new settings. 

You can now experiment with changing the colours used to represent the Rivers 
and Main cities themes (figure 7.14). 
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Figure 7.14. View dialogue box showing the world map 



Next, we will use the Legend Editor to symbolize the African countries according 
to their names. Close the World Map view and open the Africa Map. 

Double-click on Countries name to display the Legend Editor. From the Legend 
Editor click on the Legend Type field and choose Unique value from the available 
options. The Legend Editor rJ.ow displays a Values Field scroll down list. Click on it and 
select Name as the field on which you want to base the classification. Click Apply and 
close the Legend Editor. 

We have now classified our theme according to the unique values of a field of its 
attribute table (the Name fidd). We have also applied a colour to symbolize the result. 
This is just one way you can classify your features according to their values in 
Arc View. 

Figure 7'. 15. View dialogue box showing the map of Africa 

When you have finished, close the view and choose File and Close Project. If you 
want to save changes, choose Yes when prompted. 

7.9. Exercises 

7.9.1. Exercise 1: Labelling features 

In the directory c:\icstrn\arcview\ex_l, open the exl_ch.apr project from the File 
menu. 

Make Countries the active theme. 
Select a group of countries (six or seven is enough) with the Select Features 

button. (Tip: If you want to narrow or widen the selected set after the selection.) Shift­
Click over the countries yo l want to exclude or add from the selection. Choose Zoom 
In to select. 

From the menu bar, select Theme > Auto Label and press OK to accept the 
default settings. The selected countries are labelled by name. The font of the labels is 
the default size and it may be too large if we have many features to label. We can 
change the font size using the Font Palette (figure 7.16). 
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First, remove all the labels from the view by selecting Remove Labels from the 
Theme menu. 

Select Show Symbol Window from the Window menu. In the Symbol window 
select Font Palette. 

Change the font size. Close the Symbol window and repeat the Auto Label 
command. 

Figure 7. 16. Changing font palette from the Symbol window 
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7.9.2. Exercise 2: Create a chart with the selected data 

Open the Countries theme table and press the Promote button to bring the selected 
fields to the top. 

From the Menu, choose Table and then Chart. 
In the Chart Properties dialogue window, rename the chart Life Expectancy. 
In the Fields list, scroll down and highlight Life_exp and click the Add button. 

Life_exp is shown in the Groups list on the right. 
Under the Label series, choose the Name field. Click OK. 

\ilove the cursor into the Chart window (figure 7.17). You will see the Identify 
cross-hairs symbol. Click on any bar in the chart. The corresponding field will flash in 
the attribute table, the polygon will flash in the view and the Identify Results window 
will open. Arrange the windows by moving and resizing them in order to see the 
highlighted field in every window. 
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Figure 7.17. Chart window 
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7.9.3. Exercise 3: Create a layout 
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Make the view the active window. Choose from the menu bar View then Layout. 
The template manager window will pop up. Choose the Landscape default tem­

plate and click OK. 
Resize the layout window to its full extent. Every object in the view can be 

resized and arranged in the template. To change size and position. single-click on the 
object. The cursor will charrge to cross-hairs and four black squares will appear at the 
corners of the object. Click and drag in the middle of the object to change its position, 
or move one of the squares to modify the dimensions. 

To add a chart to ti:: e layout, go to the button bar, click, and hold on the last 
button. In the resulting scrcill down menu, choose the Chart icon to add a chart frame. 
The cursor changes to a cross. In an empty area of the layout window, click and drag 
the square where the chart will be displayed. 

The Chart Frame Properties window is displayed. Select the chart you created in 
Exercise 2 and click OK. Notice that the Chart should be open in order to be displayed 
in the layout template. If you previously closed the Chart window, go to the Project 
window, click on Chart and open it again. Go back to the Layout window. 

Resize and reposition the view (i.e., the north symbol, the chart and the legend) 
as if you were preparing this map composition for printing (see figure 7.18). Double­
click on the title and change it in the Text Properties dialogue window. 

You can use the zoom controls in the menu and button bar to see different 
display possibilities. Whe'.l you have finished, select Close Project and save the 
changes. 
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Figure 7.18. Life expectancy in Central Africa 

Life expectancy in Central Africa 

7. 9.4. Exercise 4: Create your own project 

Create a new project by selecting File>New Project. Save it with a name of your 
choice. 

Create a new view and add all the available themes from the c:\icstrn\arcview\ 
ex_l \world directory: 

cities 
cntry94 
lakes 
rivers 
world30 

Arrange the themes in the table of contents to make them all visible. Select the 
colour of the themes. 

Zoom in on the Mediterranean Sea area. Select all the countries that border the 
Mediterranean Sea and zoom to the selected features. 

Build a query to select all the cities in Italy and label them. Check attributes of 
the selected cities in the Attribute table. Create a chart representing the population of 
the selected cities. 

7. 1 O. Data input and integration 

GPS, which stands for Global Positioning System, is the only system today able to show 
you your exact position on the Earth anytime, in any weather, anywhere. GPS satel­
lites, 24 in all, orbit at 11,000 nautical miles above the Earth and are continuously 
monitored by ground stations located worldwide. The satellites transmit signals that 
can be detected by anyone with a GPS receiver. Using the receiver, you can determine 
your location with great precision. 
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7. 10. 1. Step 1: Modifying the global positioning system (GPS) 
log file 

From the Desktop, double-dick on the Explorer shortcut to start this program. 
Navigate to the c:\irntrn\arcview\datass folder. In the file list on the right hand 

side, double-click on GPSDATA.TXT. The text editor will show the raw data file. 
Press Enter to insert a blank row on the first line of the file. Move up to the blank 

row and type: 

East, north, hdght 

Do not press Enter after typing this text. The beginning of the file must look 
like this: 

East, North, Height 
13.40404600, 45.68185850, 0.57 
13.40418667, 45.68191033, 2.17 
13.40433167, 45.68196133, 4.07 
13.40447583, 45.68201600, 5.60 
13.40461850, 45.68207 450, 6. 72 
13.40476400, 45.68213183, 8.16 

Close the window and select YES to save the changes. Now the Global Position­
ing System data can be imported into GIS. 

7. 10.2. Step 2: Importing data in ArcView 

From the Desktop, double click on the ArcView GIS version 3.0a shortcut to start the 
program. 

After the start-up process, you are presented with the application window that 
contains an untitled window, which is referred to as the Project window in ArcView 
(figure 7.19). 

Figum 7.19. Arc View application window 
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First, we will add to our project the table that contains the GPS data. In the 
Project window select Tables and then click Add. 

In the Add Table dialogue window, click on List File and scroll-down the menu 
and set it to Delimited text (*.txt). 

In c:\icstrn\arcview\datass, select the file gpsdata.txt and click OK. The GPS 
data are imported into a new table that appears in figure 7.20. 

Figure 7.20. Table dialogue box 

m·1~~!lil!!lll!ll\llttJol1 
\:::::::::::::1~::~~~:~~~~~)t··· .. ·············~-1-1i:~~~~~·t·····················~·~i·l 141 
.............................................. ,, .................................................................................. ., --'l 

45. 68196133 ! 13. 40433167 l 4. 07 ! J ................................................................................................................................. ., .j 
45.68201600 l 13.40447583 ! 5.60 l j 

•••••••• .. Oo••••••OO•<••••••••O•O••<••••••••••"!-••••o .. ooO•O .. ooooO•••••OOO•>•oooooooooooooooooHOo} .. ooOoooooooO•••oO<••ooooooo+ooo.;: l 

45.68207450 ! 13.40461850 ! 6.72 ! l ... , .......................................... -:. .................................................. -:- ................................ .. 
.............. ~.?:.§?.?.1}1.?.~.L. ............... ~.~:.~9.~?.§~9.9..1.. ................... ?.:.J.§.) 1 
.............. ~.?:.§?.?.J.1.~§?..l ................. .J..~A9.~~~?.?.9..l .................. ~.? ... ?.§.l I 

45. 68220000 l 13. 4051 0150 i 20. 20 l ··············4·5-.·532271·1·i1··· ............... 1.i4o523?s?·r··· ............... 1.~i24·1 
·········· .. ··4·5-_·ss2334oa·r·················15_·4o53825ff f" ................ 2o:ot 
............ ··4·5·:ss24001·7·r .. ············ .. 1x4o5525sir······· .. ··· .... 2ff1·a·1 
··············4·5:ss2464ooT ............... fi:4o5s72f7r······· ......... 2iisfl 
··············4·5:·s82527oo·r ................. ,.i4os82oe?·r········ .......... :ifs4·1 
··············45·:ss25s25oT···· ........... 1.i4o596s5oT ................ 2'i.56·1 
.............. 45.'ss2sscff:n·········· .. ······1x4os1·1·;ffii··················22:s2·1 
········ .. ····4·5:s02?255ff r·················1··3.'4os25s5a·r··············· .. 22'.-ss·1 
··············45-_·ss2?8s5a·r· ................. 1'i4os401·93·r············ .. -· .. 22'.·09·1 
.............................................. -=-····················· .. ········ ................... .:. ................................ .: 

45.68285283 ~ 13.40654017 l 22.96 \ .............................................. t .................................................. ~ ................................. ~ 

Notice that the field names are the ones that you just added to the raw data file. 
You can now close the table. 

We will now create a new view with backdrop layers over which we will display 
our GPS data later in the exercise. 

7. 10.3. Step 3: Displaying Arc/Info coverage in ArcView 

The layers we are going to use are derived from the Digital Chart of the World. They 
are stored in Arc/Info format and the information has a maximum detail of 
1:1,000,000. To create a new view, first click on View icon in the Project window. 

Then, click New and view 1 opens. 
We will now change the properties of the current view before adding the themes 

to it. From the View menu, select Properties (see figure 7.21). The View Properties 
dialogue is displayed. Change the Name of the view to GPS and GIS. 

Under Map Units, click the scroll-down menu and select decimal degrees; under 
Distance Units, ensure that meters is the defined unit. 

Click OK to apply the settings to your view. 
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Figure, 7.21. View properties dialogue box 

We can now begin adding our themes to the view. Click the Add Theme button. 

The Add Theme diabgue box is displayed. Directories appear in the right scroll­
ing list and spatial data sources in the left scrolling list. In c:\icstrn \arcview\datass 
you can see the feature data sources that are available. 

The icons on the leL represent the Arc/Info coverage derived from the Digital 
Chart of the World. Single click over the Hynet icon. Three different feature types 
become available: polygon. arc and labelpoint. Click Polygon and press OK. 

In the view, draw the theme by a Click on the following icon. 

We will use a previously created legend to display this theme. Open the Legend 
Editor by double clicking on the Hynet theme from the table of contents. The Legend 
Editor is displayed (figure 7.22). 

Figul'e 7.22. Legend editor dialogue box 

Click on the Load button and in the Load Legend dialogue box select hynet.avl. 
Press OK once then OK <•gain in the subsequent dialogue box. 

In the Legend Editor, you now have the six classes of altitude with their labels. 
Click the Apply button and close the Legend Editor. The theme is now classified ac­
cording to the altitude inbrmation in the theme attributes table (figure 7.23). 
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Figure 7.23. Classification of altitude according to the theme attributes table 

We can now add the theme depicting the political boundaries. Click again on the 

Add Theme button. 

Select the Ponet folder. Click the Polygon option and press OK 
Draw the theme (this will hide the Hynet cover, but we will alter the fill prop­

erties in order to see them both). Double-click the Ponet theme name to launch the 
Legend Editor. 

From the Legend Editor choose Unique value for Legend Type. In the Values 
field select Popytype, which indicates that you want the unique values contained in 
that field of the attributes table. 

Two rectangular boxes will appear. Double-click on the first to open the Fill 
Palette window. Select the blank box in the upper left corner of the box (figure 7.24) 
to draw only the outline of this polygon. Close the Fill Palette window. 

Figure 7.24. Fill Palette dialogue box 
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Double-click on the second rectangular symbol box. Click the Colour Palette 
button at the top of the Fill Palette to switch to the Colour Palette. 

Change the colour to light blue. 
In the Legend Editor click Apply and close the Legend Editor. Now you can see 

both themes again, the blue colour represents bodies of water. 
We will now add one more theme, which is a square polygon in the northern 

Adriatic Sea region. Add to the view the theme named Studyarea.shp. Display the 
view and start the Legend Editor. 

In the Fill Palette window select the blank box to display only the outline of the 
polygon. Close the Fill Palette window. 

Select Apply and close the Legend Editor. 

1=igure 7.25. Study area selection 

Make study area the active theme by clicking on the check box. Click the Zoom 
to Active Theme(s) button. 

The View is now ce1tered in the Gulf of Trieste area. At this point, we are going 
to display the theme containing the main cities and the road network. Click the Add 
theme button and select the Pppoint folder with the point option feature type. 

Launch the Legend Editor. Double-click on the Symbol and change its colour to 
black using the Colour Palette. 

Select the Font Palette button and set the font size to 7. 

[~i] 
From the Menu bar choose Theme. Select Auto Label and press OK to accept the 

default settings. This will identify cities by name. 
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Figure 7.26. Study area extradion 
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7. 10.4. Step 4: Saving work in a project file 

In order to save the changes made so far to this untitled project you should save it and 
give it a name. Click on the Save button. 

Choose a name for your project and press OK. 
You can save the changes made to your project file at any time. Remember, 

however, that when you save your project you are just creating a text file that contains 
the references to the spatial and attribute source data on your hard drive (or else­
where), and the definitions of how these data have to be represented and linked for 
that particular project. No data duplication or modification occurs when you are saving 
your project file. 

7. 10.5. Step 5: Joining tables 

In the first compact disc in the Digital Chart of the World series there is a subdirectory 
called Utilities \Metadata that contains attribute information concerning the coverage 
in ASCII text file format. In order to classify the themes according to this information 
we have to join the theme attributes table and the external tables. We will do this for 
the theme representing the road network. From the Project Window select the Tables 
icon and click Add. We will first add the external text file. Select rdln.txt and click OK. 

The table has two fields: Rdlntype is the key field for joining the data and 
Type.desc is the field that carries the information about the road type. Do not close the 
table window. Select View. 

We will now add the features for the road network. Click the Add Theme button 
and select the Rdline folder. Select Arc as the feature option this time. 
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Display the theme and click on its name to make it the active theme. 
Click the Open Theme Table button to see the theme attributes table. 

Figure 7.27. Attributes table 

Figure 7.27 shows a ;ypical Arc/Info attributes table; the first seven fields from 
the left carry the topological information. The fields to the right of Rdline_id are user­
defined and carry attribut1~s of the cover containing all attributes. 

In order to join the two tables you first must select the key field (i.e., rdln.txt) in 
the source table. 

Without closing any windows make rdln.txt the active window (be careful not to 
select any records in the table). Single-click on the Rdlntype field name. The name will 
be highlighted. 

Now make Attribute~; of Rdline the active window and repeat the selection of the 
Rdlntype field name. The name is highlighted also in this table. 

Now it is possible to join the two tables. Click the Join button. 

In the Attributes of Rdline table you now also have the Type.Desc field. Close the 
Attributes table. 

Notice that the two original files have not been changed, and only the parameters 
that define the join operation can be saved. Click on the Save Project button to record 
the join operation. 

Each time you open this project, the join operation will be executed during the 
initialization procedure. 

We can now use this information to classify the theme according to the road type. 
From the View, double-click on Rdline to launch the Legend Editor. 

Under Legend Type, :::hoose Unique value. 
In the Values field, scroll down to select Type.Desc (which is the field we have 

just joined). 
To change colours you may double click each symbol and change the colour using 

the Colour Palette, or selecr; one of the predefined palettes in the Colour Scheme scroll­
down menu. 

Once you have changed the colours, click Apply. Close the Legend Editor and 
you will be able to see the classified cover (features) in the view window (figure 7.28). 
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Figure 7.28. Classification of features according to the road type 
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7. 7 0. 6. Step 6: Creating an event theme with the GPS data 

~ow that the thematic background has been prepared, we want to see where the GPS 
points that were collected in the field survey are located on the map. With the view 
active, select Add Event Theme in the view menu. 

Figure 7.29. Add Event Theme dialogue box 

X field; 

Yfleld North 

Specify gpsdata.txt as the Table containing the information. Select East as the X 
field and North as the Y field (figure 7.29). Click OK. 

Display the resulting theme (Gpsdata.txt) (figure 7.30). If you wish to change the 
colour of the points, use the Legend Editor, and then use the Zoom to Active Theme 
button to display the theme. 
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Figure 7.30. Displaying the resulting theme 

We have not yet created a Point theme for ArcView. We have only created a 
representation of a series of coordinates with the height attribute. In order to make 
Point theme we must convert it to a Shapefile, which is the native format of informa­
tion storage for ArcView. 

With Gpsdata.txt the active theme, select Convert to Shapefile from the Theme 
menu. 

Give it a name (e.g., GPSpoint). Click OK and Accept to add this theme to the view. 
We can now remov~ Gpsdata.txt from our view and keep only the Shapefile 

theme. 
Make Gpsdata.txt the active theme and select Delete Themes from the Edit 

menu. Confirm your choice. 
If you want to see the height information of the points, use Zoom In and use 

Identify buttons to retrieve the altitude information from the attributes table. 

You can now save the changes to the project. 
You have successfully completed the integration of GPS and GIS data and cre­

ated a project that will display your field survey information on a thematic back­
ground. 

7. 11. Land use destination using GPS data 

In order to determine the land use destination of a study area, we will analyse the 
polygon theme and we will associate all GPS data of the area with other features. 

7. 11. 1. Step 1: Open the project and set the study area 

From the Desktop, double-click on the Arc View GIS version 3.0a shortcut to start the 
program. 
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After the start-up process, navigate to the c:\icstrn\arcview\datass\land folder 
and open the Project named zoning.apr. 

Open the view named GPS to GIS in the Project window (figure 7.31). 

<{: Gp<pointA/lp 

• 
<{, /'pf'Ol'I' 

• 
<l f/ltllflO 

/' .j OM""tor wit 
Du#/Jan~ (dht 
Pri••'Y affll .& 

T4Ck. Viii. Ot 

'ff; S!<Jdya,.a.~p 
CJ 

,(, P<;q9f 

CJ1 
CJ2 

~ Hyn9' 
CJ0.000• 
CJi!<)Q.11)0~ .. 
~IOCQ,-2()1)0" 
11111111 2000.~CfXhl 
11111111., .. ,,401'0., 
D 

Figure 7.31. GPS to GIS project window 
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We now must add the polygon theme that we want to analyse in order to deter­
mine its land-use destination in terms of the spatial relationships with other features. 
Click on the Add Theme button to add the Landuse.shp theme to the view. 

Display the theme, and make it active by clicking on its name. 
Use the Zoom to Active Theme(s) button to zoom in on the area of interest. 

The automatic zoom does not allow you to see the features around the Landuse 
polygon. You can use Scale to zoom out and see a larger area. 

The Scale indicator is in the upper-right corner of the Arc View interface. It shows 
the scale of representation, which was selected earlier when we assigned view prop­
erties (to decimal degrees). To view a large area, change the value of the scale by typing 
50,000 in the Scale box. The view redraws to a smaller scale. 

Scafe 1: 32,662 

Use the Legend Editor if you want to change the colour of the polygon. 
Before starting the spatial operations, we will arrange the themes so that we can 

see the GPS points displayed on top of the Landuse polygon (figure 7.32). From the 
table of contents of the view, click on Gpspoint and drag it to the top. 
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Figure 7.32. C>isplay of GPS points on the land use polygon 

7. 11.2. Step 2: Buffering the GPS points 

The GPS wa ypoints that were collected and imported into GIS represent the 
route of a highway that intersects the area of interest. According to a simulated land­
use planning criterion, we will propose that the portion of the area that is in a range 
of 200 m from the highway will be destined for general commercial district use. The 
remaining portion will be classified as an industrial district area. 

In order to distinguish. these two different areas, we will make use of the spatial 
analysis capabilities of Arc View. First, we will create a Buffer Polygon theme around 
the GPS waypoints. We will then overlay the Buffer theme and the Landuse theme and 
create a theme with the two different areas. 

Finally we will modify the attributes table of the new theme and use the link 
operation to select the polygons according to their destination. We must then load the 
Xtools extension that will provide the spatial analysis tools that we need. 

Make the Project window the active window. 
Select Extensions from the File menu. Click the check-box next to Xtools Exten­

sion and press OK. The Xtools Extension is now working. Go back to the view. 
First, we need to select the points to buffer. They should only include those points 

that fall in the Landuse theme. This selection is performed with a theme-on-theme 
selection. 

Make gpspoint.shp the active theme. From the Theme menu choose Select by 
Theme. 

There are several tyr::es of theme selections. In this case, however, we will select 
only the features in the gpspoint theme that intersect with the Landuse.shp and that 
represent our area of interr~st. Use the scroll-down button to specify the correct selec­
tion option (Intersect) as well as the theme you are going to use for the selection 
(figure 7.33). Press New Set. 

In the view you will see that only the points over the Landuse theme are high­
lighted in yellow. This means that they have been selected. 

Now that we have the selected set, we can buffer these points. 
We are now going to create a buffer of 200 m around the selected points using 

the Xtools Extension. From the view window, open the Xtools menu and choose Buffer 
Selected Features. 
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Figure 7.33. Selection of features of active theme 
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As successive dialogue windows appear, use the scroll-down lists to select the 
correct following options for each choice: 

Buffer units 
In theme 
Out theme 
Buffer input 
Buffer distance 
Output structure 

meters 
gpspoint.shp 
enter road_buf 
buffer distance 
200 
contiguous 

Click in the view and then click on the road_buf check box to display it 
(figure 7.34). 

Figure 7.34. Display of roads 
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Click Save button to save the changes made so far to the project. 
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7. 11.3. Step 3: Topological overlay 

You will notice in the view that the road buffer extends outside the border of the 
Landuse polygon. We will therefore overlay these two themes with the identity option. 

The identity option creates a new theme by overlaying two sets of features. The 
output theme contains all cf the input features and only those portions of the identity 
theme that overlap the input theme. 

Make Landuse.shp tbe active theme. 
In the View, choose Identity from the Xtools menu. As successive dialogue win­

dows appear, use the scrol 1-down lists to select the following options for each choice: 

Input theme 
Fields for output 
Select Identity :heme 
Fields for output 
Name new theme 

Landuse.shp 
select Zoneid and OK 
road_buf.shp 
select Buf_id and OK 
Destination 

The overlay is performed and the theme is added to the view at the bottom of the 
list. Click on the new theme and drag it to the top of the list; release the mouse button 
to display the theme (figure 7.35). 
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!Figure 7.35. Overlay of theme 

To see the attributes table of the resulting theme, make Destination the active 
theme. Click on the Open Table button. 

{ 

The second field on the left is the ID, which is the unique identifier of the two 
resulting polygons. Click on the first row and look into the view to see which of the 
polygons is highlighted. Repeat the same step for the second row of the table. 

Use the table to dete:'mine what the correct Land_code values are for the two 
land use destinations. Make a note of these values as you will need them later. 
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The table in figure 7.36 describes the general commercial district for the area 
near the highway and the industrial district for the area at least 200 m away from the 
highway. 

Figure 7.36. Table showing the correct Land_code values for the land use­
destinations 

1 1.6.dministrative t: Professional ................................................. <····· .. ··· ....................................................................... . 
2 1 Educational District ...................................................... ;.. ..... ,. .................. " .............................................................. . 
3 1 Gen er al Commercial District .................................................... ¢>····························· ............. .................................. f ......... . 
4 1 H iqhwav Cornmercial District 

................................................. -> ....... ':': .......... ~ ............................................................ . 

5 1 I ndt~strial District .................................................. ···-> ............ ~···· ................................................................... .. 

6 1 Li•Jht Industrial District . -................................................. ·•••(- ... •••'I• ..................................................................... ~~··· ........ . 

7 1 Multiple F .3mily Fl esidenti.31 District 
................................................. -> ................................................................................ . 

8 i t·.·1 ultiple Family Residential District , 
................................................. ->··· ............................................................................. . 

91 Open Land District ..................................................................................................................................... 
.......................................... }.~~.l. . .I.~.?.~~1.~~~-ig_~~l:~.1 ................................................... .. 

We will now add a field to the attributes table of the Destination theme in order to 
store the Land_code ID. Make the attributes table of the Destination theme active. 
Unselect any selected record by clicking over the Unselect button: 

Choose Start Editing from the Table menu. Select Add Field from the Edit menu. 
Change the name of the field to Land_code and press OK. 

In the tool bar click on the Edit button, and then click on the blank record in the 
Land_code field. 

Using the table in figure 7.36, type in the Land_code that you noted previously 
and press Enter. Type in the code for the second record and press Enter. 

Choose Stop Editing from the Table menu and save the changes. 

7. 11.4. Step 4: Linking tables 

We will now link the theme's attribute table with an external table that describes the 
land-use destinations. 

In the external table file, add the description of the land-use destination follow 
the same steps used to assign the Land_code identifier. 

From the Project window select the Tables icon and click Add. 
Browse to find c:\icstrn\arcview\datass\land 
Select landcode.dbf and click OK. 
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The table has two fiElds. The Land_code field is the essential field for linking the 
data and Destination. Thb field carries the information about the road type. Do not 
close the Table window. Click on the view. 

Make Destination the active theme. Click on the Open Theme Table button to 
view the theme attributes table. 

In order to link the two tables you first must select the key field in the source 
table (i.e., landcode.dbf). Without closing any windows, make landcode.dbf the active 
window (be careful not to select any records in the table). 

Single-click on the Land_code field name. The name should be highlighted. 
Make Attributes of Destination the active window and repeat the selection of the 

Land_code field name. The name is also highlighted in this table. 
It is now possible to link the two tables. From the Table menu select Link. Click 

on the Save Project button to record the link. 
Now that the tables are linked you can use the Select Feature button in the view 

to highlight one of the Destination polygons (figure 7.37). 

l·b[ Select Feature icon 

This will select the corresponding records in both the attributes table and in the 
landcov.dbf table. 

Figure 7.37. Highlighlring one of the destination polygons using linked table 

7. 12. Georeferendng raster images 

Satellite imagery that has been georeferenced can be purchased, but you should con­
sider georeferencing it yo lrself, for these reasons: 

0 Better results can be achieved in reducing the positional error of an appli­
cation; 

0 The image georegistration, through resampling, transforms the original im­
age and introduces spatial distortion. This entails performing an additional 
operation after the spectral transformations (Principal Component Analy­
sis, indices) and classifications have been executed. 
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An image can be registered without coordinates if the coordinates of certain 
features are correct and if they can be identified on your map as well as on the following: 

0 A paper map 

0 The ground, using traditional methods or a global positioning system 

0 A digital vector map 

0 An image that has already been georeferenced 

IDRIS! creates a correspondence file (a simple ASCII file) for georeference opera-
tions that has the following structure: 

npoints 
Xunref 
Xunrefl 
Xunref2 
Xunref3 

Yunref 
Yunrefl 
Yunref2 
Yunref3 

Xref Yref 
Xrefl Yrefl 
Xref2 Yref2 
Xref3 Yref3 

Xunref and Yunref are the false coordinates of a feature in the image to be 
georeferenced. Xref and Yref are the coordinates of the features in the real world, and 
npoints represents the number of correspondence points. IDRISI uses an equation to 
register and transforms the image into a new one. The following steps explain this 
operation. 

Start IDRISI from the Desktop. The graphical user interface is displayed. 
From the environment menu choose ENVIRON. Change the path of working data 

directory to c: \icstrn \idrisi\georef and select OK. 

From the Display menu, select Display Preferences and check that the option to 
display the output of analytical modules is set to "on". Double-click the quantitative 
palette input box. Select Complig and click OK. Do the same for the qualitative palette 
and for the default palette. This will provide the results or images of any modules that 
are displayed with a colour composite scale palette unless another palette is specified. 
If necessary, unselect both the Use Extended Cursor Inquiry and the Show Legend. 
Close the Display Preferences window. 

From the Display menu choose Display Launcher or click on in the toolbar. The 
map composition launcher dialogue is displayed. 

Select tar4 to be displayed with the grey256 palette, autoscaling and an expan­
sion factor of 1. This display is a near-infrared band, produced from a set of images of 
a mountain area about 150 km north of Trieste (figure 7.38). Click OK. 

Now run Describe from the File menu. 
Select tar4 from the list. You will see the image specifications (figure 7.39). It has 

301 columns, 301 rows and no coordinate system is specified. The minimum and 
maximum x and y values have been typed during an import procedure and for conven­
ience have been given according to the number of rows and columns. 

Close the Describe window. 
Move the mouse on to the image and look at the coordinates displayed in the 

status bar. Columns (c:) and X coordinates (x:) match; however the rows (r:) and Y 

coordinates (y:) do not. This occurs because the origin of the rows and the columns is 
displayed in the upper left-hand corner while the origin of the x, y reference system 
is in the lower right-hand corner. 

Now try to identify these features. Since the image is not that clear (figure 7.40), 
enhance it by creating a colour composite called tar234 with tarR2, tar3, tar4 and with 
a percent saturation of 2.5 (DISPLAY, COMPOSIT). (See figure 7.41.) 
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Figure 7.38. Landsat Thematic Mapper (Band 4) 
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Start the Display Launcher from the Display menu and select Vector as the 
type of file to be displayed. Select RIVERS for both the input and palette files. Check 
the scale bar box, check the north arrow box and the grid box. Another window will 
be displayed. In the increment X and increment y input boxes type 1000 to have a grid 
spacing of 1 km on the vector map that you are going to display (figure 7.42). Click OK. 
Click OK on the Display :Oauncher window. You will have to wait for the map to be 
displayed. 
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Figure 7.40. Image enhancement 

Figure 7.41. Landsat TM image (composite bands 234) 
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Figure 7.42. Identification of the watershed 

In order to georegist1~r the map, you should find the points that are common to 
the image (TAR234) and to the digital map of the rivers projected in UTM-32 that you 
have just displayed. As we have a digital layer of rivers, we can use river intersections 
as control points. 

Focus on the Rivers map. Select Add Layer in the Composer window. 
In the Input box, double-click and select AREA. In the Symbol File Input box, 

select AREA again. Click OK. Image TAR234 shows the rivers and approximates our 
study area (see figure 7.4l ). 

Create a correspond1~nce file using DATA ENTRY /EDIT or clicking on the 

From the ASCII file text editor window, select the Correspondence file as the file 
type to be edited. 

Select CORRES in the right-hand window and click OK. You will see the file 
structure as previously described. A number of ground control points (four, as speci­
fied in the first row) have been inserted. 

Identify the river intersections in both the image and the rivers maps. Add points 
to the Correspondence file by clicking inside the window and typing (as if typing in a 
common text editor). 

If you are not succeEful, try the operation again. Without closing the text editor, 
focus on the rivers map aJd select Add Layer in the Composer window. Try to find 
good points for the image registration. 
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In the Input box double-click and select REFER. Accept all defaults and click OK. 
You will see a set of three points corresponding to the three river intersections that are 
also visible in the TAR234 image. These are additional points to add to include in the 
correspondence file. 

There are two ways to improve your view of the TAR234: 

0 Click once on the Zoom button and once on a point in the image to magnify 
by a factor of 2. To go back, click again on the Zoom button on the tool bar 
and then click on the image with the right mouse button, 

or, 

0 Click once on the Window button on the tool bar and draw a window 
around the point to be magnified. To restore to the original size, click the 
Window button again and click on the image with the right mouse button. 

It is difficult to determine a precise position for river intersections in the TM234 
image because of the coarse cell resolution (there is a 30 metre resolution of the ground 
details on pictures received from the Landsat satellite). As can be seen, resampling is 
a very time-consuming and exacting task. 

Identify the river intersections (points) on the TM234 image. For each of the river 
intersections, do the following and note the results on a piece of paper: 

4 

0 Focus on TAR234 and record the x and y coordinates that you can read in 
the status bar; 

0 Focus on RIVERS and record the corresponding x and y coordinates that 
you can read in the status bar (e.g., X_TAR234, Y_TAR234, X_RIVERS, 
Y_RIVERS). 

Figure 7.43. IDRISI text editor window 
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Once you have done this, go back to the IDRISI text editor window (figure 7.43) 
and start modifying the correspondence file by adding 3 rows with xold, yold, xnew, 
ynew (each of the 3 new points should be separated by the TAB key). In the first row 
change the total number of control points from 4 to 7. 

Click Save and Clme the Text Editor window. 
You now must resample the image according to your control points. From the 

REFORMAT menu start RESAMPLE. 

Figure 7.44. Image resampling and geometric correction 
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Select TAR234 as the input file, type TAR234R in the output file input box 
(figure 7.44). 

In the Correspondence file input box select or type CORRES, which is the control 
points file you have just finished editing. 

Since you need other information (i.e., the minimum and maximum x and y for the 
new resampled image and the new reference system) select DESCRIBE from the File 
menu to read the documentation about the files. Select Vector files as the file type 
(figure 7.45). 

From the Select fik list, choose AREA which is the vector file delimiting the 
study area (figure 7.45). Review the descriptions in the window: 

0 Record the reference system and the reference units; 

0 Record min X, max X, min Y, max Y. 

Select Cancel. In the Resample window (figure 7.46) select the reference system, 
the reference units and type in the values for min X, max X, min Y, max Y. 

In both columns and rows type 300. Using the calculator on the Windows desk­
top, calculate whether th~ cell resolution is 30 m (the resolution of Landsat images) in 
both x and y directions by dividing (xmax - xmin)/300 and (ymax - ymin)/300. 

Accept all defaults and click OK in the Resample window. You will see the Re­
sample window with the global residual positional error (the RMS root mean square), 
and the error for each :ontrol point, calculated through the best-fit equation. This 
represents the probability that a mapped position will vary from the true location. 
According to United States national map accuracy standards, the RMS should be less 
than half the resolution of the input image. According to the input image units, it 
should be less than 0.5. 
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Figure 7.45. Document file description 
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Figure 7.46. Resampling residual error (RMS) 
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To familiarize yourself with the calculations for the residual error, select a point 
in the Resample window with a high RMS error and click on Omit a point and then 
on Recalculate. See if the total RMS error decreases. Select the point again and click 
on Restore a point and Recalculate. 

Even if the error is greater than 0.5, click OK. The resampling process starts and 
the new georeferenced image will be displayed. You will also see a text report on the 
transformation. Focus on this window and click on the Save button to save these 
results. Accept resultsl.txt as a file name and click OK. Close the Results window. This 
file should be stored together with the image to give information about its positional 
accuracy. 

Close all windows except for the TAR234 resampled window. 
To display the digital map with rivers again, start the Display Launcher from the 

Display menu and select Vector as the type of file to display. 
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Select RIVERS from the Input file and the Palette file. Check the Scale bar box, 
the North arrow box and the grid box; another window will be displayed. In the 
increment X and incremen: y input boxes type 1000 to have a grid spacing of 1 km 
on the Vector map that ycu are going to display. Click OK. 

Select OK in the Display launcher window. Wait until the map is displayed. 
Select Add Layer in the Composer window. 
Superimpose the study area on the map. In the Input box, double-click and select 

AREA. In the Symbol File input box select AREA again. Click OK. 
We will now visually verify the georeferenced points by displaying the rivers 

over the image. Focus on TAR234 resampled and click on Add Layer in the Composer 
window. 

Select RIVERS as the Vector file to display and RIVERS as the Symbol file. Click 
OK. The rivers will be displayed over the new georeferenced image (figure 7.47). 

Compare the image and the map. 

Figum 7.47. Rivers overlay on the georeferencecl image 
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7. 13. Siting f>roiecll for perfonning spatial analysis in ArcView 

From the Desktop, double-click on the Arc View shortcut to start the program. 
Navigate to the folder c:/icstrn/arcview /siting and open the Project named 

siting.a pr. 
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Open the View named Data implementation from the Project window. Together 
with the windows of the available digital information, the administrative boundaries 
are drawn. 

From the table of contents, display in the View the following themes: 

Infra_33n 
Infra_33s 

These line themes represent the road network and the main infrastructures. Due 
to the tiling system, we must first derive a new theme that contains all the features of 
both themes. This can be accomplished with the Merge function. The result of this 
operation is represented by the theme named Infra_merge.shp. Turn on the theme 
Infra_merge.shp to see the result. 

The analysis will be conducted only in a part of the administrative district; you 
can see the study area by displaying the theme named Area.shp. Display Area.shp. 
This is the same extent that you have previously used to display the digital terrain 
model within IDRIS!. We now have to use this window to select the infrastructures 
that fall within this area of interest. 

We will use the polygon to define the extent of the study area in order to clip the 
infrastructure theme and create a new line theme that contains only the infrastruc­
tures present in the area of interest. Select Clip with Polygon(s) from the Xtools menu. 

Select the following options in the successive dialogue windows that will appear 
(use the scroll-down lists to select the correct option for each choice): 

Input theme Infra_merge.shp 
Clip theme Area.shp 
Name new theme Infraclip 

At the bottom of the table of contents, the theme is displayed. Click and drag the 
theme to the top of the list. 

Display the theme and press Zoom to Active Theme. 
In order to save the changes made so far to the project, click on the Save button. 

Once you have completed this phase, you can close the view. 
In the Project window open the view named Industrial siting. 
In the View, you will find the following themes displayed: 

0 Area 

0 Infrastructure (which you created with the clip) 

0 Rivers (derived with the same procedure as the infrastructures theme) 

0 Sites (representing the possible lots we have to select) 

We will now load the results of the analysis performed by IDRIS!. Use the Add 
Theme button to load c:\icstrn\arcview\siting\ALTITUDE.SHP. 

Display the theme, and make it active by clicking on its name. 
Double-click the name to start the Legend Editor and load the already prepared 

legend named altitude.avl. Click OK twice and then Apply. Close the Legend Editor. 
From the Theme menu choose Show /Hide Legend. 
Arrange the themes in order to see the infrastructure and rivers displayed over 

the Digital Terrain Model (figure 7.48). 
Use the Add Theme button to load c:\icstrn\arcview\siting\FLAT.SHP, which is 

the map of the slope. 
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Figure 7.48. Infrastructure and rivers displayed over the Digital Terrain Model 
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Use the Legend Editor to give the map a colour of your choice and to display the 
theme (figure 7.49). 
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Figure 7',49. Infrastructure and rivers displayed 
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According to the requirements for our potential sites, we know that: 

0 The slope of the lot cannot be greater than 15%; 

0 The lot should be in an altitude range of between 700 and 900 above sea 
level. 

We will now extract from the two themes only those areas that meet both re­
quirements. 
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Make Altitude the active theme and start the Query Builder. 

In the Query Builder dialogue window, type in the following expression: 

( [Quota] <= 900 ) 

Press New Set to execute the expression and close the dialogue window. The 
areas highlighted in yellow satisfy the expression (figure 7.50). 

Figure 7.50. Pre-selection of area to highlight according to their altitude 
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We can now perform a clip between the Flat and Altitude themes in order to 
extract only the areas in the altitude range with a slope that is acceptable for the siting. 
Select Clip with Polygon(s) from the Xtools menu. 

Select the following options in the successive dialogue windows that will appear 
(use the scroll-down lists to select the correct option for each choice): 

Input theme 
Clip theme 
Name new theme 

Altitude.shp 
Flat.shp 
Topography 

Drag the theme to the top and display it (figure 7.51 ). 
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Turn off the Altitude and Flat themes and drag their names to the bottom of the 
list since we will not need them during the successive analyses. 

We now will classify the Topography layer according to the altitude information. 
Start the Legend Editor. 

Set Legend type to Unique Value and the Values field to Quota. 
Select Apply and cbse the Legend Editor. The first criterion map for the site 

selection is now ready (figure 7.52). 

1=igure 7 .. 52. New theme with complete legend 

We can now preparE the map that meets the Land-use type criterion. 
The lot must be included as one of the following Land Uses: Urban Areas, Crop 

Patches or Bare Ground. Vie now must load the land-cover map in the view and join 
the table containing the de::cription of the land-cover types. We will then build a query 

to select only the required classes. 
Add the Landcover.shp theme to the view and display it. 
In the Project window select the Tables icon and click Add. 
Browse to the directory c:\icstrn\arcview\siting. 
Select land_code.dbf' and click OK. 
The table has two fields. Corine_id is the necessary field for linking the data and 

the description, the second field carries the information about the land-cover type. Do 

not close the table window or click on the view. 
Make Landcover.shp the active theme. 
Click the Open Theme Table button to look at the Theme Attributes table. 

The Land_ code field is at the right side of the table. Without closing any windows 
make land_code.dbf the active window (be careful not to select any records in the 
table). 

Single-click on the Corine_id field name. The name should be highlighted. 
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Now make Attributes of Landcover.shp the active window and select the 
Land_code field name. This name will also be highlighted in this table. It is now possible 
to link the two tables (notice that the join procedure works even if the essential fields 
have different names). 

Press the Join button. 

Close the Attributes table. 
This information can now be used to classify the theme according to the land-use 

type. In the table of contents, double-click on Landcover to launch the Legend Editor. 
A legend file named landcover.avl already exists, so just choose Load. 
Press OK twice, select Apply and then close the Legend Editor. The resulting 

map is shown in figure 7.53. 

ti on. 

Figure 7.53. Land cover with detailed legend 
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Now we can select the land-use polygons according to their descriptive informa-

Make Landcover the active theme and start the Query Builder. 

In the Query Builder dialogue window, type in one of the following expressions: 

([Description]= Crop patches) or ([Description]= Bare ground) or ([Descrip­
tion] = Urban areas) 

Press New Set to execute the expression and close the Query Builder dialogue 
window. The resulting map is shown in figure 7.54. 
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Figure 7.54. Selection of land use polygons according 
to their descriptive infonnation 

The next step is to us~ the topography layer and to intersect it with the selected 
land-cover polygons we have just highlighted. Notice that this time we are using Inter­
sect and not Clip, as we wa rit the new theme to contain both the altitude and the land­
type information. 

In the View, choose I:rrtersect Themes from the Xtools menu. 
Select the following OJtions in the successive dialogue windows that will appear 

(use the scroll-down lists to select the correct option for each choice): 

Input theme 
Fields for output 
Select Intersect theme 
Fields for output 
Name new theme 

Landcover.shp 
select Corine>Description >OK 
Topography.shp 
select Quota >OK 
Landsuit 

Drag the theme to the top of the list and display it (figure 7.55). 
Open the Attribute fable to ensure that both the altitude information and the 

land-cover types are present. Close the table. 
Start the Legend Editor and set Legend type to Unique Value and the Value field 

to Description. 
Colour the two symbols bright red and pink. 
Click on Apply and then close the Legend Editor. 
In the resulting screen (figure 7.56) you will see the areas that meet both topo­

graphic and land-cover type parameters. 
Notice that during the last intersect the bare ground land type was excluded 

from the suitable areas because it did not meet the altitude-slope parameters. 
Turn off the Topography and Landcover themes and drag them to the bottom of 

the table of contents. 
Now use the Infrastructure theme to exclude the lots that are too close to exist­

ing residential buildings according to the criterion "the lot has to be at least 100 m 
away from residential areas". Make Infrastructure the active theme. 
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Figure 7.55. Land suitability 

Figure 7.56. Areas that meet both topographic and land cover type parameters 
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Start the Query Builder and type in one of the following expressions: 

([Type] = buildings) or ([Type] = residential) 
Close the Query Builder to see the result (figure 7.57). 
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Figure 7.57. Ulse of tlie infrastructure theme to exclude the lots that are too 
dose to existing residential sites 
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We can now create a buffer area around the selected features. In the view, choose 
Buffer selected features from the Xtools menu. 

Select the following options in the successive dialogue windows that will appear 
(use the scroll-down lists to select the correct option for each choice): 

Buffer units 
In theme 
Out theme 
Buffer input 
Buffer distance 

meters 
Infrastructures.shp 
enter build_buf 
buffer distance 
100 

Line buffer options Line 
Output structure contiguous 

Click on the View of the build_buf check-box to display it (figure 7.58). 

Figure 7.58. Creation of buffer areas 
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In order to save the changes made so far to the project, click the Save button . 

.\'ow we must add the previously created buffer for the water proximity factor 
according to the criterion "priority has to be given to those lots that are closer to water 
sources, and in any case the plant cannot be sited more than 150 m away from water". 
Click on the View and use the Add theme button for water_bufs. 

Display the theme and start the Legend Editor to classify the theme with gradu­
ated colour. Set the value field to Distance and choose the colour ramp named Blue­
green monochromatic. Then use the label button to invert the colour scale; click Apply 
and close the Legend Editor. 

Drag the Rivers theme to the top in order to view it over the buffer and Zoom 
In to see the buffers better (figure 7.59). 
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Figure 7.59. Overlay of rivers theme 
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We can now start the site selection analysis by combining all the criteria that our 
sites have to meet. 

In the table of contents, arrange the themes in the following order from top to 
bottom: 

Sites 
Infrastructures 
Rivers 
Landsuit 
Build_buf 
Water_bufs 

Turn off all the other themes. 
The resulting map is shown in figure 7.60. 
Make Sites the active theme. 
From the Theme menu choose Select by theme. 
Specify that you want to select the lots that intersect the theme containing the 

buffer area around the buildings (Build_buf) (figure 7.61) and press New Set. 
Now open the Attributes theme table for Sites. 
Press the Switch selection button: 
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Fi!Jure 7.60. Site selection analysis 

Figure 7.61. Selection of features of active theme 
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Close the table. This process has allowed us to select the lots that are outside the 
100 m buffer zone around residential buildings (figure 7.62). 

Figure 7.62. Selection of lots out of a lOOm buffer zone 
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Now we must selec: the lots that are within 50 m of the road network. Make 
Infrastructures the active theme. 
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Run the Query Builder and type in quotes: 

( [Dxf_layer] = "E*" ) 

Press New set and close the Query Builder. Make Sites the active theme again. 
From the Theme menu choose Select by Theme. 

Figure 7.63. Selection of the features of active theme according 
to the buffer distance 
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Specify the parameters (as shown in figure 7.63). Since we have already selected 
some of the lots in the Sites attributes table, we can choose the Select from Set option 
to narrow the selection. 

Again, open the Attributes table to ensure that other lots have been excluded; 
close the table. The map shown in figure 7.64 appears. 
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Figure 7.64. Excluding other lots 

We are now going to perform a spatial join operation in order to verify which of 
the remaining lots satisfy the last two criteria, i.e., the proximity to water and topo· 
graphical characteristics. 

Open the Landsuit.shp theme attributes table and click on the Shape field. 
Open the Sites.shp theme attributes table and click again on the Shape field. 
Press the Join button. 
In the attributes table you will find that only those lots with a suitable land·cover 

type receive the attributes from the Landsuit cover attributes table. All the other fields 
are left blank, which means that these lots do not satisfy the criteria and will be 
discarded. We will use this process to find lots that meet the criteria for water proximity. 
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Open the Water_bufs.shp theme attribute table and click on the Shape field. 
Open the Sites.shp t1eme attribute table and click again on the Shape field. 
Press the Join button. 
Examine the Sites att:ributes table (figure 7.65). From the table that contained 15 

possible sites, only 2 remain that meet all the criteria we have defined. These are 
shown in yellow in figure 7.66. 

Figure 7.65. l'able of attributes where only 2 sites remained having met all 
criteria we have defined 

Fi!~ure 7.6,6. Remaining sites that meet the criteria 
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7. 14. Siting proieiet for performing surface analysis in IDR~SI 

In Display /Display preferences unselect the Use extended cursor inquiry and select 
QUAL256 as the qualitative palette, QUANT256 as the quantitative and ALTI as the 
default palette. In the map defaults verify that both Title and Legend are checked. 

From the Display, run Display Launcher. The name of file to display should be 
TARDEM. Double-click in the input box and then OK. A digital raster elevation model 
that was obtained through the interpolation of scattered elevation points from a digital 
map will be displayed (figure 7.67). 
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Figure 7.67. A digital raster elevation model that was obtained through the 
interpolation of scattered elevation points from a digital map 
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From the Composer window, click on Add Layer. 
To display Area as a vector file. select Area as the symbol file. Our study area 

will be superimposed to the elevation model. 
As you can see, we are interested in a small area. To avoid consuming processor 

time, we will extract a sub-image from the digital elevation model before performing 
our surface analysis. Run Window from the Reformat menu (figure 7.68). 

In the input image text box select or type TARDEM. 
In the output image text box type TARWIN. 
Select the option to specify a window by the geographic positions. 
Obtain the minimum and maximum x and y coordinates to type into the 4 input 

boxes by either: 

0 Focusing on the image window and pointing the cursor in the proximity of 
the corners of the study area superimposed by TARDEM and looking at the 
x and y values in the status bar. The obtained values that have been 
rounded to the nearest hundred can be used, or 

0 Run Describe from the File menu. Select Vector files as the file type and 
click once on AREA to read its document file. Note the minimum and 
maximum coordinates, rounded to the nearest hundred, in the four coordi­
nate boxes of the Image windowing window. 

Click Cancel on the Documentation file description window. 
Accept all other defaults and click OK. The image will be displayed (figure 7.69). 
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Figure 7.68. Image windowing 

Figure jr.69. Window from the TARDEM image 

In the Composer window, click on Properties. 
In the Layer properties window double-click on the palette file box to select ALTI 

as the palette file and click OK The new digital elevation model (DEM) has the correct 
combination of colours. 
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Now you can begin performing the surface analysis on the DEM to satisfy your 
project task From the Analysis/Context operators menu, run SURFACE or click on 

which is located on the toolbar. 
Choose to calculate slope by selecting TARWIN as the input elevation model. 

Type TARSLOPE in the output slope image input box. Choose the option to calculate 
the slope as a percentage. As a conversion factor, type 1. In the title input box type 
Percent slope from TARWIN and click OK. The map in figure 7.70 will appear. 

Figure 7.70. Percent slope from the TARWIN image 
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In the Composer window, click on Properties. 
In the Layer properties window, double-click on the palette file box to select 

Slope as the palette file and then check the Use legend box. Click OK. 
The map of the slope has a legend; by using the scroll bar you can look at the 

range of values for the study area. The slope steepness ranges from grey to green to 
yellow to red. 

Since we are interested in finding areas with a slope of less than 15 percent, we 
must reclassify the slope image in order to obtain a new image displaying suitable and 
non-suitable areas. 

Click on the reclass button in the toolbar. 

The image reclassification window (figure 7.71) is displayed. 
In the Type of file to reclass, choose Image. 
ln the Classification type, choose User defined·reclass. 
In the Input file, type or select Tarslope 
In the Output file, type Flat 
In the title input box type Areas with slope less than 15%. 
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Figure 7.711. lma~1e classification and reclassification IDRISI window 

Now start assigning classes to values by filling the input boxes in the right part 
of the window. Assign a new value of 1 to all values from 0 to just less than 15. 

Click on the right arrow to scroll to assign a new set of values. 

Assign a new value of 0 to all values from 15 to just less than 100000 (greater 
than the image maximum to include all values). 

Click OK and a new image will be displayed. The pixels in the image represent 
the flat areas with a slope of less than 15 percent and as you can see from the legend, 
they have a new value of 1. 

We are now going to collect all the data in ArcView to take our final planning 
decisions. In order to do SJ we need to transform the raster polygons in Flat by: 

0 Converting them into a vector format 

0 Exporting them into the specific Arc View shapefile 

Before converting our raster flat areas to a vector file, we will use a filter to 
remove very small areas considering only polygons that are of a significant size. From 
the Analysis/Image_proccssing/Enhancement menu, run Filter. The Filter window 
(figure 7.72) is displayed. 

Select Mode as the t:rpe of filter. This will reassign values of one pixel according 
to the predominant value cf its neighbours, thereby generalizing the image. In the input 
image input box type Flat [n the output image input box type FLATFIL. In the title box 
type FLAT areas filtered with mode. (See figure 7.73.) 

In the Reformat/Ra1;ter-vector Conversion menu run Polyvec. You should nor­
mally enter FLATFIL as the input image and FLATFIL as the output vector file and 
exclude the background pclygon that is identified by the value of 0 in the image (areas 
with a slope of more than 15 percent). However, we will not perform this operation 
now, since it takes about 1 ~i minutes to do on a PC. The output of this module is already 
saved in your directory ao: FLATFIL and it is a vector file. 

Display this vector file using the Display Launcher from the Display menu 
(figure 7.74). 
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Figure 7.72. Digital filtering using a moving Kernel window of 3 by 3 pixels 
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Figure 7.73. Raster flat areas 
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Figure 7.74. !Raster flat areas using filter as image enhancement procedure 

In this file the lines appear very jagged. So we will smooth it before exporting it 
to the ArcView format. Run Linegen from the Reformat menu (figure 7.75). 

Figure 7.75. Vector line generalization 

Select FLATFIL in the input file box; type FLATGEN in the output file box. 
Select Low-pass filtering and click OK. 

A window showing the results of your smoothing is displayed. Close this window. 
Now display the vector map you have just created. Run the Display Launcher 

and select Vector as the file type to display. In the input box select FLATGEN. Accept 
all the other defaults and click OK. 
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::\ow compare (visually) FLATFIL (figure 7.76) and FLATGEN (figure 7.77). 

Figure 7.76. IDRISI to Arc View file export 
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Figure 7.77. The file is ready to be included into an Arc View project 
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There is still one step prior to exporting to the ArcView format. Run Convert 
from the Reformat menu and choose a vector file type. In the input file box type 
FLATGEN, and in the output box type FLATGE. Accept all other defaults and click 
OK. You are now going to convert an integer ASCII vector file to an integer binary 
vector file. 

From the FILE menu run Import/Export. From the IDRIS! import/export utility 
Export/software-Specific Formats menu, run Shapeidr. 

In the input IDRIS! vector file select FLATGE. In the output shape file type FLAT. 
Accept all other defaults and click OK. The file FLAT is now ready to be included 

into an ArcView project. 
Having completed these steps, you should be able to perform other operations, 

including: 

0 A reclass on the Digital Terrain Model (TDM) to have a 100 m altitudinal 
belt 

0 A conversion to a vector polygon file of the altitudinal belt 

0 A generalization of the polylines 

0 An export to E,hapefile for Arc View 

The maps resulting from these operations have been included in the Arc View 
project. 
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8 Case studies 

Landscape ecology analysis 
and urba1n land use classification 
in the Sebaou watershed, Algeria 
A. Altobelli and L. Ourabia 

Multi-criteria evaluation 
for industrial siting in the region 
of Tunis-l~ize1rte, Tunisia 
M. Ghribi 

Landscape araalysis of degraded 
and degradir1g areas of Tigray, Ethiopia 
A. Altobelli 
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Case study 1 

Landscape ecology analysis 
and urbc1n land use classification 
in the Selbao1u watershed, Algeria* 

1. Introduction 

Watershed deterioration is a common phenomenon in most parts of the world. A 
prime cause is the improper utilization of watershed resources, which is a severe 
problem in developing co1ntries [1]. Vegetation loss and land degradation resulting 
from unsuitable agriculture practices is of particular importance in predominantly 
mountainous regions, such as north central Algeria. Monitoring changes in land cover 
is essential to improving watershed management. 

Remote sensing is very useful in assessing the land cover of an area at a particu­
lar time and monitoring change over a given period [2, 3]. 

The test area selected for our study is a coastal watershed (the Sebaou water­
shed) located in north central Algeria (figure 1). The area of the watershed is about 
2,460 km2 and has an estimated population of 1,302,077, and population density of 
457 inhabitants per km2

• It is bordered on the north-west by the Mediterranean Sea, 
on the north and north-ea:st by a coastal mountain range and on the south and south 
east by the Djurdjura Movntains. It is 80 km east of Algiers, the national capital, and 
is considered a strategic basin for the water supply of several Governorates. 

Figure 1. Location of the study area 
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'This case study was prepared by A. Altobelli and L. Ourabia, Area of Earth. Environmental and 
Marine Sciences and Technologie3, ICS-UNIDO. 
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2. Landscape ecology analysis of remote sensing data 

This part of the case study focuses on the calculation of three of the most commonly 
used landscape indices, namely: 

0 Dominance index 

0 Contagion index 

0 Fractal dimension index 

2. 7. Data extraction 

Different types of images have been used-two land-cover images (supe92RR and 
supe98RR) and a grid image where geographic operation units (OGU) are presented. 
All analysis will be computed using these images. To display both of the land-cover 
images, use palette qualitative 256 and legend. 

The first step in calculating the three indices is to isolate five OGU. The identifiers 
for the randomly selected OGU are 89, 108, 198, 185 and 80. 

To isolate the OGU with identifier 89, select Analysis Database Query>Reclass 
(see figure 2) for Input file, enter OGU. Enter a name for the Output file. 

Assign a new value of 0 to all values from 0 to just less than 89. 
Press the arrow on the right side of the screen and assign a new value of 0 for 

all values from 89 to just less than 90. Press the arrow again and assign a new value 
of 0 to all values from 90 to 300. Press OK. 

Figure 2. RECLASS IDRISI module window 

A Boolean image will be displayed where the OGU has a value of 1 and the 
remaining part a value of 0. 

Repeat the same operation to isolate the OGU identifiers 108, 198, 185 and 80. 
We will now isolate the land cover image of the OGU for both land-cover images 

(supe92RR and supe98RR). Select Analysis>Database Query>Overlay (see figure 3). 
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Figure 3. OVERLAY IDRISI module 

Enter the following [n the Overlay window: 

First image: OGU 2 
Second image: supe92RR 
Overlay option: First*second 

Press OK. 

Follow the same procedure for all the OGU and for both land-cover images 
(supe92RR and supe98RR). 

Select Analysis>Database Query> Area (figure 4) to calculate the area of each 
land-cover category. For the Input image enter the OGU with the correspondent land 
cover. For Output format select Tabular and for Calculate area as select Square 
kilometers. 

Figu1·e 4. Area calculation IDRISI module 
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Select Analysis>Database Query>PERIM to calculate a perimeter for each land cat­
egory type (figure 5). 

For Input image enter the same OGU used to calculate area. For Output format 
enter Tabular output. Calculate the perimeter in kilometers. 

Figure 5. Perimeter calculation IDRISI module 

Repeat this process to calculate the area and the perimeter of each land-category 
and for each OGU. Record the results in a table. 

To determine the number of patches for each OGU select Analysis>Context 
operators>Group (see figure 6). 

Figure 6. GROUP IDRISI module 
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For Input image enter the name of the corresponding OGU with land cover. Enter 
an appropriate name for Output image. Check the box for Include diagonals. Include 
a diagonal and Press OK. 

For Input image enter the same OGU used to calculate area. For Output format 
enter Tabular output. Calculate the perimeter in kilometers. 

Repeat the operation for all OGUs corresponding to both land-cover images. 
In order to see the number of patches, check the maximum value for each 

grouped image in the Documentation file (figure 7). 

Figure 7. Documentation file description IDRISI window 

2.2. Data analysis 

The three landscape indices were computed using the LAND program written in 
qbasic. To run this program, go to the qbasic directory and enter this command: 
QBASIC LAND. 

Input the following for each OGU: 

0 Pixel resolution: 20 m2
• 

0 Number of cla:;ses: 5 (since we have five land-cover categories). 

0 Number of patches: 2159 (in 1992) and 2279 (in 1998), see table 3. 

0 Area for the 5 landscape categories (Al, A2, .... A5). 

0 Perimeter of 5 landscape categories (Pl, P2, ... , P5). 

Press Enter, the values for the three indexes for the first OGU will be displayed. 
Follow the same procedure for the other OGUs. 
The following tables (table 1. 2 and 3) contain data values obtained: 

Table 1. Area of land-cover categories 

OGU2 OGU3 OGU4 OGU5 OGU6 
1992 199/i 1992 1998 1992 1998 1992 1998 1992 1998 

Category 1 0.0316 o.oo:~ 0.4660 0.1940 1.6548 1.6244 0.5988 0.6296 0.9372 0.6924 
Category 2 0.1:)96 0.081)4 1.9284 1.8932 1.0356 0.7292 1.8604 1.4120 0.7820 1.0756 
Category 3 0.8440 0.311)4 1.3616 1.7784 0.9352 1.2004 1.2040 1.7996 1.7360 1.6120 
Category 4 0.6052 2.77138 0.1416 0.0400 0.2412 0.2980 0.2212 0.0968 0.4796 0.4596 
Category 5 2.3596 0.82·! 0.2280 0.0148 0.0560 0.0684 0.0756 0.0220 0.0252 0.1204 
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Category 1 
Category 2 
Category 3 
Category 4 
Category 5 

Table2. Perimeter of land-cover categories 

0Gl2 
1992 

3.679 
15.320 
42.000 
42.920 
48.160 

1998 

0.36 
12.00 
21.04 
75.440 
57.640 

OGU2 
OGU3 
OGU4 
OGU5 
OGU6 
Total 

OGU3 OGU4 OGU5 
1992 1998 1992 1998 1992 

37.920 20.68 67.400 70.440 44.200 
74.000 132.998 70.440 80.640 76.200 
68.520 130.958 57.680 98.079 64.161 
19.16 5.239 29.2 22 28.24 

2.5599 2.16 6.5199 9.07 4.7999 

Table 3. Number of patches 
in land-cover categories 

1998 

43.400 
115.119 
117.518 

9.28 
2.9199 

,,.umber of patches 1992 Number of patches 1998 

286 
398 
515 
451 
509 

2159 

257 
313 
664 
439 
606 

2279 

3. Urban land use classification 

OGU6 
1992 1998 

55.760 51.4006 
49.360 106.319 
72.400 116.838 
54.040 32.3601 

3.559 12.84 

The following exercises will try to give you an overview of IDRIS! capabilities and 
show you some ways of carrying out a specific analysis dealing with vegetation moni­

toring. 

3. 7. Exercise 7 

Create a map displaying urban density. 
The two main images that we will use for this exercise are the land-cover image 

(designated as Clustw, 12 classes representing land-cover) and administrative borders 
of the area (Communes, 10 communes). Use palette qualitative 256 to display both of 
them. 

Isolate the communes situated along the main river (Sebaou valley). They are 
listed with the corresponding identifiers as follows: S. Daoud (63), Delys (65), Baghlia 
(64), Tadmait (30), S. Namman (66), DBK (29), T. Ouzou (26), T. Rached (37), Freha (56), 
Mekla (39). 

To isolate these communes we will first create a value file where the commune 
identifiers will have a value of 1 and other identifiers have a value of 0. 

Access the File menu and select Edit>Show File contents, choose the value file 
Valley 1 and ensure that the communes listed above have a value of 1 and the others 
a value of 0 (figure 8). Save the file and exit. 

From the Data Entry menu, select Assign>Attribute Values Assignment. For 
Future definition image, type Communes; for the Attribute value file enter Valleyl; for 
the Output image, enter comval (see figure 9). 

You should obtain a Boolean image in which the communes of the valley have a 
value of 1. 

Isolate the land-cover image of our study area (the buffer zone is the Sebaou 
valley). 

From the Analysis menu select Database Query>Overlay. 
Enter comval as the First image, clustw as the Second image and cluswval as the 

Output image. Select first*second as Overlay options (figure 10). 
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Figur·e 8. V1alue file representing the selected communes 

Figure 9. Elaboration of a Boolean image 

Go to Display> Map Composition Launcher. For Type of file, select Image file; for 
Name of file to display, type cluswval. Select Qualitative 256 for the Palette and check 
Legend under Map compositions (figure 11 ). 
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Figure 10. Overlay module to isolate the land-cover for the study area 

Figure 11. The display module for map composition launcher 

Go to Composer (on the right side of the screen) >Add Layer>enter City2 with 
Palette cities. ~ote that the urban categories present attribute No 10. 

Go to the Analysis menu and select Image processing>Transformation> 
Texture. 
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Enter the following options (see figure 12): 

Type of analysis: Class frequency 
Input image: enter cluswval 
Output image: enter Tizil 
Size of area for calculation: select 7 x 7 
Input class value to count: 10 (it corresponds to the urban category). 

Press OK. 

Figure 12. TexturEi analysis to calculate the frequency of urban pixels 

To create a map dem,ity value, open the Analysis menu and select Mathematical 
operator>scalar. 

Enter the following information (see figure 13): 

Input file: ente' Tizil 
Output file: type Tizi2 
Operation: divide 
Scalar value: eater 37 

Press OK. 

Display the output using Quant 256 Palette option. 
Go to the Display menu and select Image Histogram (see figure 14). Type Tizi2 

for the input image and 0, 01 for the class width. 
Select Analysis>Database Query>Reclass to classify the image Tizi2 in three 

main categories defined fr::im the histogram. Name the output image Tizi3. 
The three categories of urban density are: 

Class 1: Low urban density (from 0.01 to 0.30) 
Class 2: Medium urban density (from 0.31 to 0.59) 
Class 3: High urban density (from 0.60 to 1) 
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Figure 13. Urban density calculation using the module scalar 

Figure 14. Image histogram module 

To display Tizi3 select Urbanden as the Palette option and add the following 
Vector files from the composer: Limits, city2, city2'. Save the result as a map com­
position file. Give it a name. 

Create a second image to show the industrial area in the valley. For the Map 
Layer enter Industry, for the Text Layer enter INDTXT. Use the Urban density map as 
the base map with the Vector file: limits, industry and INDTXT. Save the result as a 
map composition file from composer. 
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Calculate the area of each category and each commune (one by one). Take as the 
transect the commune situated along the main river. You should then isolate commune 
by commune. Use the method explained at the beginning of this section to isolate the 
necessary communes. 

To calculate the area select Database query>Area (see figure 15). For the Input 
image enter Commune isoi'ated; for the Output format select Tabular and for Calculate 
the area as select Square kilometers. 

Figure 1 5. Determining the areas of the communes 

3.2. Exercise 2 

Calculate the NOVI average. 
In this exercise we will calculate the NDVI average for selected communes lo­

cated along the Sebaou river. These communes are listed as follows with their corre­
sponding identifiers: S. Dwud (63), Delys (65), Baghlia (64), Tadmait (30), S. Namman 
(66), OBK (29), T. Ouzou (26), T. Rached (37), Freha (56), Mekla (39). 

In the Reclass module we will create a Boolean image where the urban categories 
will have a value of 0 and the non-urban area will have a value of 1. 

For the input image enter Tizi3. 
Name the output image sebal. 
To obtain a NOVI image without the urban categories we should overlay the 

Boolean image sebal with NOVIAW (Pallet NOVI 256). Name the result seba2. 
Select Analysis>Database Query>Extract to obtain the NOVI average for the 

corresponding images. 
Enter the following (figure 16): 

Future definition images: Communes 
Image to be processed: seba2 
Output type: tabular 

Press OK and save as extract.txt. 
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Figure 16. Calculating the NDVI average for each commune 

This process provides a series of values corresponding to the NDVI average for 
each commune of the Sebaou valley. You can either print or export these values to 

statistical package for further analysis. 

3.3. Exercise 3 

Find the relation between urban density and vegetation index NDVI. 

Figure 17. Regression analysis between NDVI average and urban density 
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Calculate the NDVI average for the 37 categories corresponding to the urban 
density categories for the image Tizil. 

Use the module Extract but, instead of choosing Table for output, type Table, 
select Values File. Name l:he output file avndvi. 

Use the Value File Density as an independent variable. (The Value File Density 
is available within the database created by the author.) 

Now you have all the necessary data to conduct regression analysis (Analysis> 
Statistics>Regression) be:ween the two value files. Use the density file as the inde­
pendent variable and avndvi as the dependent variable (see figure 17). 

The result should be as shown in figure 18. 

Figure 18. L.inear ccirrelation between NDVI intensity and urban density 

:: 152.842169- 0.897548 x 
157.5648 

r = -0.9728 

164.0980 
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The correlation between the NDVI intensity and the urban density confirms a 
highly significant negative correlation between the two parameters with R = -0.9728. 

4. References 

1. Food and Agriculture Organization of the United Nations. Tropical Forestry Action Plan, 
Committee on Forest De'relopment in the Tropic. Rome, 1985. 
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Case study 2 

Multi-crit'eric1 evaluation for industrial 
siting in t~he region of Tunis-Bizerte, 
Tunisia* 

1. Description of the study area 

Human settlements in the Mediterranean basin have existed since ancient times and 
have had a profound impact in the flora and fauna of the region. Consequently the 
Mediterranean system offers a very interesting field for investigations on human im­
pact [l ]. The region of Tunis-Bizerte in Tunisia has been selected for study because it is 
typical of the Mediterranean environment. It is located on the coast of the Gulf of Tunis 
in north-eastern Tunisia (s,~e figure 1 ). 

Figure 1. Location of the study area 

2. Purpose 

Pame!Jeria 
(ITALV) 

The present exercise designs a suitability map depicting the sensitivity of the coastal 
areas of the region of Tunis-Bizerte to the establishment of industries. It consists of 
landscape evaluation for industrial siting and includes a GIS technology developed for 
the IDRIS! geographic information system software. 

3. Procedure 

Open IDRIS! for windows [2] from your Desktop and select Analysis>Decision 
Support>MCE (see figure 2). 

Multi-criteria evaluation (MCE) is a decision-support tool [3]. A decision is a 
choice between alternatives (such as alternative actions, land allocations etc.) [4]. In 
MCE, an attempt is made to combine a set of criteria to achieve a single composite basis 
for a decision according to a specific objective. 

"This case study was prepared by M. Ghribi, Area of Earth, Environmental and Marine Sciences and 
Technologies, ICS-UNIDO. 
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Figure 2. Multi-criteria evaluation IDRISI module window 

A GIS-based methodology is integrated by using the Weight IDRISI module. The 
concept consists of inserting interactive effects of several contributing factors (table 1) 
and constraints that may contribute in enhancing or decreasing industrial susceptibility. 
The factors are raster images containing the target features from which distance is 
measured using the Distance IDRISI module (figure 3). The constraint, on the other hand, 
is used to exclude certain areas from consideration (such as water and reserved lands). 

Table 1. Factors contributing to the change 
of industrial susceptibility 

Factors File name 

1 97CT\1lJD.img 
2 97lJT\1ID.img 
3 97lJT\1RD.img 
4 97CT\1WD.img 
5 97CT\1FD.img 
6 97CT\1BD.img 

Description 

Proximity to main urbanized areas 
Proximity to main industrialized sites 
Proximity to main roads 
Proximity to water (sea, lakes and rivers) 
Proximity to protected forests and national parks 
Proximity to bare soils 

Using the IDRISI MCE function, these criteria images were combined to form a 
single suitability map from which the final choice can be made. The output will consist 
of a certain number of categories, each reflecting its susceptibility to the installation of 
new industries and urban-area expansion. 

In MCE, using a weighted-linear combination, weights are derived from a 
PAIRWISE comparison between factors. The comparisons concern the relative impor­
tance of two criteria in determining suitability. 

Select Analysis>Decision Support>WEIGHT, select use a previous PAIR­
WISE comparison file, enter the file name 97UTMPW and click the Continue icon 
(figures 4 and 5). 
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Figum 3. Distance IDRISI module window 

Figur1~ 4. WEIGHT IDRISI module window 
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Figure 5. PAIRWISE comparison 

The weights are developed by providing a series of pairwise comparisons of the 
relative importance of factors to the suitability of pixels for the objective being evalu­
ated. Ratings are provided on a continuous nine-point scale from extremely less impor­
tant to extremely more important (figure 6). 

Select Calculate weights to produce the eigenvector of weights (figure 7). 
The result is a set of factor weights used by a weighted-linear combination in the 

multi-criteria evaluation (figure 8). 

I 

j 

Figure 6. Continuous nine-point scale for the pairwise comparison 

IGHT -MIP W!light Derivation £i 

37UTMU£;1 9rurw1r:r · 
97uri;ff\f:113 
smr@T17i 
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1. ' 

Figure 7. The eigenvector of weights generated from the pairwise comparison 

f rhe eiger~;ector ot ue1~hts 1s 

I 
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97UTID<DB 
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0.2505 
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I 

I 
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Figu1e 8. Multi-criteria analysis procedure 

4. Industrial suitability map 

The suitability map 97UTMMCE.img is used as a first raster layer for which we will 
overlay all the factor layers to get a final suitability map 97MAPFIN.img displayed 
with a palette file "97suit" (figure 9). 

Figure 9. Suitability map for industrialization 

5. Interpretation 

No Cale. 
\IJ<'f.eJ 

flood• 
5em.MJlbarll".ceci Qii;!a:i: 

U1~teda1ea 

!ndv:stt~;ir.:e.d a<f.!4S 

E :ct1e.rnet; J:;.Y.one to OOwi 1.·~;Jt1err.e.:t e:r<l ro,;~h~ 

S!:0<'9i>;P<'l!'<O 

l34S 

The suitability map produced from a multi-criteria evaluation shows different degrees 
of susceptibility to new industrial plants. As shown in figure 9, the extremely prone 
areas are concentrated around the main existing industrial sites (Echarguia, Ariana, 
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Ettadhamen, .\1annouba, Mateur, Menzel Bourguiba and Bizerte), in the urbanized areas 
and along the coast. Areas that are highly prone to industrial development are 
characterized by: 

0 Proximity to an existing industrial zone in which there is a high probability 
that infrastructure and an organized industrial system exist; 

0 Proximity to residential and commercial sites fulfilling the requirement for 
social activities. The availability of a large number of workers will satisfy 
labour requirements for industrial activities; 

0 Proximity to main roads and good connections with markets; 

0 >Jatural allocations (coast, rivers, lakes, slope etc.), which can represent an 
environmental constraint. 

6. References 

1. Food and Agriculture Organization of the United Nations. A framework for land evaluation. 
Soils bulletin (Rome) 32, 1976. 

2. Idrisi for Windows user's guide. Clark Labs for Cartographic Technology and Geographic 
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multi-objective decisions. Photogrammetric engineering and remote sensing, 61:5:539-547, 
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national journal of geographic information systems, 5:3:321-339, 1991. 
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Case study 3 

Landscape analysis of degraded 
and degrading areas of Tigray, 
Ethi~~pia* 

1. Introduction 

In this case study we wil. use two new indices of fragmentation and path shape com­
plexity for the landscape ecology analysis of remotely sensed data. The traditional 
indices of contagion [1] and fractal dimension [2, 3] will be replaced by two new indices 
called patch-per-unit area (PPU) and square-pixel (SqP) [4]. These indices are independ­
ent of the variations of spatial resolution in remotely sensed data and are very sensi­
tive to actual changes in the landscape pattern. They will be applied to each of the 21 
tabias (administrative units, see map 1) of the Tigray region in northern Ethiopia in 
order to study the structure and distribution of the areas most exposed to the risk of 
soil erosion. 

Map 1. Location o·f the tabias (administrative units) of the Tigray region 
in northern Ethiopia 

no data 
Tsegereda/Worerba 

2 Mel hay 
3 Maytium - 4 Eshir 
5 Tahetay Logomty 
6 Asay 

D 7 Gedeba 
8 Laelay Logomty 
9 Addis Alem - 10 Lakenay - 11 Wochi 

12 Zonghi 
13 Golgolo 

• 14 Zebenege 
15 Vihdet 
16 Nequa - 17 Workamba - 18 Malkua 
19 Ketema 
20 Endafelasi 
21 Golagule 

"This case study was pr:opared by A. Altobelli, Area of Earth, Environmental and marine Sciences 
and Technologies, ICS-UNIDO. 
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A technique for the simulation of alternative land cover types (cropped lands 
into woodlands) will be applied in one area of industrial development, with the objec­
tive of reducing the risk of soil erosion. 

Various data types of land cover will be stored and processed in the geographic 
information system using IDRISI 2.0 [5] and PCRaster softwares [6] for Windows 95 
or T\T. The land-cover map is produced by means of Landsat Thematic Mapper (TM) 
images with the support of a ground truth survey. 

The data to be used are derived from the final report of a project funded by the 
European Union [7]. 

2. Land cover map 

The classification of the Landsat TM images is performed using unsupervised and su­
pervised techniques. The map obtained from the unsupervised classification is used to 
sample the training areas for the supervised method. The accuracy of the classification, 
evaluated by the mean of a confusion matrix, approaches 90 per cent. The land-cover 
classes for map 2 are as follows: 

1. Woodland 
2. Evergreen scrubland 
3. Grassland 
4. Open woodland 
5. Bushland 
6. Cropland 1 (tef) 
7. Cropland 2 (wheat, barley) 
8. Cropland 3 (sorghum, maize) 
9. Cropland 4 (wooded cropland) 
10. Bare soil 1 
11. Bare soil 2 
12. Rock outcrop 

Map 2. Land-cover map obtained from a Landsat-TM satellite image 

no data 
1 Woodland 
2 Evergreen scrub 
3 Grassland 
4 Open woodland 
5 Bushland 
6 Cropland 1 
7 Cropland 2 
8 Cropland 3 
9 Cropland 4 

10 Bare soil 1 
11 Bare soil 2 
12 Rock outcrop 
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The bare soil 1 category is located in a karstic depression. The bare soil 2 cat­
egory contains all the areas without or with very little (less than 5 per cent) vegetation 
cover and consists of ploughed lands or fallow lands on steep and stony hillsides. 
Further descriptions of the land-cover classes can be found in the final report on 
rehabilitation of degraded and degrading areas of Tigray, northern Ethiopia [7]. 

3. Potential! soil erosion model map 

The map that shows the potential soil erosion for the area is calculated using the 
following maps: 

0 Slope map 

0 K-factor map 

0 C-factor map 

3. 7. Slope map 

The slope map is calculated from the digital elevation model (DEM) (map 3). Three 
classes of slopes, express,~d as percentages, are defined: 

slope 

0-10% 
>10%-20% 

>20% 

slope.class 

1 (mild erosion) 
2 (medium erosion) 
3 (severe erosion) 

The slope map witb the three percentage classes is shown in map 4. 

3.2. K-factor map 

The K-factor map is obtained from the geomorphological unit map (map 5). The K 
values for each unit were estimated on the basis of the physical properties of the most 
characteristic soil types in. the area (see table 1): 

Table 1. Geomorphological units 
<and corresponding K-factor values 

Geomorphological unit 

Town 
Erosion surface-shallow soil 
Scarps/denutational rock slopes 
Undulating badlands 
[nfield valleys 
Alluvial plain and terraces 
Erosion surface remnants with soil cover 
Alluvial fans 
Severe badlands 

K 

0.00 
0.10 
0.15 
0.20 
0.23 
0.25 
0.25 
0.27 
0.31 

Class 

1 
1 
1 
2 
2 
2 
2 
2 
3 

The following K-factor classes were defined to produce map 6: 

K-factor Kfactor.class 

0.1-0.2 

>0.2-0.30 

>0.30 

1 (mild erosion) 
2 (medium erosion) 
3 (severe erosion) 
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3.3. C-factor map 

The C-factor, indicating the level of protection of a soil type under a certain land cover, 
was estimated using data from the literature (applied to a similar area) and information 
from the geomorphological map. The C-factor values given in table 2 were assigned to 
the different land-cover types. 

Table 2. Land-cover types and corresponding 
C-fador values 

Vegetation types 

Rock outcrops 
Grassland 
Woodland 
Scrubland 
Open woodland 
Open scrubland 
Crop 3 (sorghum. maize) 
Crop 2 (wheat, barley) 
Crop 4 (wooded cropland) 
Bare soil 1 
Crop 1 (tel) 
Bare soil 2 

The C-factor values were divided into four classes: 

Vegetation type 

C-factor 

0.00 
0.01 
0.01 
0.02 
0.05 
0.06 
0.10 
0.15 
0.15 
0.15 
0.25 
1.00 

Cfactor.class 

Woodland, evergreen scrubland, grassland, rock outcrops 
Open woodland, open scrubland 

1 (no erosion) 
2 (mild erosion) 

Croplands, bare soil 1 
Bare soil 2 

3 (medium erosion) 
4 (severe erosion) 

A C-factor map corresponding to the four classes described above was produced 
(see map 7). 

The general formula [8] to calculate the potential soil erosion (pse), for each pixel, is 

pse = n/100* [.(wi*map) 
i""l 

where, 

map; = the category value for the pixel in the i-th map 
w; = the specific weight assigned to the i-th map 
n = the number of input maps 

The formula applied to the data in the case study was: 

pse = 3/100*(40*slope.class + 30*Kfactor.class + 30*Cfactor.class) 

The resulting pse values were subdivided into seven classes as shown in table 3 
and the corresponding map was produced (map 8): 
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Table 3. Potential soil erosion classes 

Potenlial soi' erosion (pse) 

1.0 3.5 
>3.5 4.5 
>4.5 5.5 
>5.5 6.5 
>6.57.5 
>7.5 8.5 
>8.5 9.5 

4. Landscape indkes 

pse.classes 

1 
2 
3 
4 
5 
6 
7 

The fragmentation index ppu (patch-per-unit), used as an alternative to the traditional 
contagion index, is given by following the formula [4]: 

ppu = m/(n*A) 

Where m is the total number of patches, n is the total number of patch pixels in 
the considered tabia, and A is a scaling constant equal to the area of a pixel. As the 
landscape becomes more fragmented, the ppu index increases. 

The other index, Sqf'. was introduced to quantify complexity, replacing the fractal 
dimension. SqP considers the relationship between perimeter and area ofraster data and 
normalizes the perimeter /area ratio to a value between 0 (for squares) and 1 (maximum 
perimeter, edge and deviation from that of a perfect square). SqP is given as: 

SqP = l-(4*Nl2/P) 

where A is the tota. area and P is the total perimeter of all the patch pixels in 
the considered tabia. 

The cultivated areas with the highest erosion risk were extracted from the land­
cover map and potential SJil erosion map. The two new landscape indices were applied 
the resulting map showin;; the areas most at risk for each tabia. 

The results obtained from the application of these indices were compared, for 
each tabia, with the percentage of pixels with high risk of soil erosion (hse) and the 
density of population (dp; per hectare. 

The indices were calculated in IDRISI following the steps listed below: 

1. The cultivated pixels (land.classes 6, 7, 8 and 9) were selected from the 
land-cover maJ (map 2) by means of Reclass; 

2. The cultivated pixels with the highest erosion risk (pse.classes 6 and 7) 
were extracted from the potential soil erosion map (map 7) using Reclass; 

3. The two resu: ting maps were multiplied using Overlay; the final map 
(map 8) resultng from this operation is in Boolean format (0,1); 

4. Map 8 was employed to identify contiguous groupings (patches) of pixels 
(including thoEe set along diagonals), using Group. According to this pro­
gram, all pixel:; belonging to the same patch are given the same identifying 
number, a unique integer identifier which is numbered consecutively 
(map 9); 

5. Map 9 was used to calculate, for each tabia, the total number of patches, the 
total number ·Jf pixels grouped and the total area and perimeter of the 
patches, employing Area and Perimeter programs (table 4). 
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Table4. Parameters, indexvaluesandstatisticaldataforeachof the ta bias considered 

Tabia m 

1 142 
2 197 
3 347 
4 54 
5 516 
6 149 
7 147 
8 143 
9 165 

10 242 
11 361 
12 382 
13 216 
14 337 
15 371 
16 284 
17 231 
18 318 
19 310 
20 657 
21 243 

n 

3844 
1949 
4034 
1298 
7763 
3313 
2441 
3152 
1425 
3741 
3372 
4810 
1972 
2948 
4273 
2163 
1764 
2275 
2441 
3721 
2188 

2402500 
1218125 
2521250 

81125 
4851875 
2070625 
1525625 
1970000 
890625 

2338125 
2107500 
3006250 
1232500 
1842500 
2670625 
1351875 
1102500 
1421875 
1525625 
2325625 
1367500 

p• 

106500 
75850 

149850 
35800 

266700 
91100 
75850 
94050 
58150 

126100 
135950 
183450 
84250 

127300 
158200 
98750 
76400 

105000 
111550 
187450 
91050 

.\'ates: The pixel size is 25 m, the pixel area is 625 m 2 

m is the total number of patches 

n is the total number of patch pixels 

A is the total area of all the patches 

P is the total perimeter of all the patches 

PPI.; is the patch-per-unit index (fragmentation) 

SqP is the square-pixel index (complexity) 

PPU 

0.0369407 
0.1010775 
0.0860188 
0.0416025 
0.0664691 
0.0449743 
0.0602212 
0.045368 
0.1157895 
0.0646886 
0.1070581 
0.0794179 
0.1095335 
0.1143148 
0.0868242 
0.1312991 
0.1309524 
0.1397802 
0.1269971 
0.1765654 
0.1110603 

hse is the percentage of pixels with high risk of soil erosion 

dp is the density population (per hectare) 

SqP 

0.941784 
0.9417963 
0.9576151 
0.968176 
0.9669637 
0.9368181 
0.9348629 
0.9403055 
0.9350831 
0.9514959 
0.9572866 
0.9621945 
0.9472911 
0.9573484 
0.95868 
0.9529032 
0.9450262 
0.9545743 
0.9557091 
0.967458 
0.948626 

The identifiers in column correspond to the following tabias: 

NPT" 

23753 
27867 
56474 

6558 
61170 
17193 
16991 
19015 
23152 
42063 
55568 
57908 
33421 
43924 
72327 
52881 
44793 
70415 
32716 

110358 
87904 

hse 

16.2 
7.0 
7.1 

19.8 
12.7 
19.3 
14.4 
16.6 
6.2 
8.9 
6.1 
8.3 
5.9 
6.7 
5.9 
4.1 
3.9 
3.2 
7.5 
3.4 
2.5 

dp 

5.03 
1.43 
1.9 
7.4 
1.05 
2.82 
3.84 
2.53 
2.77 
1.15 
1.15 
1.2 
1.73 
0.74 
0.55 
0.56 
0.79 
0.46 
1.38 
0.32 
0.22 

(1) Tsegereda/Worerba; (2) Melhay; (3) Maytium; (4) Eshir; (5) Tahetay 
Logomty; (6) Asay; (7) Gedeba; (8) Laelay Logomty; (9) Addis Alem; (10) Lakenay; (11) 
Wochi; (12) Zonghi; (13) Golgolo; (14) Zebenege; (15) Vihdet; (16) Nequa; (17) 
Workamba; (18) Malkua; (19) Ketema; (20) Endafelasi; (21) Golagule. 

The results obtained from the application of these indices were compared, for 
each tabia, with: 

0 The percentage of surface area with high risk of soil erosion (hse) 

0 The density of population (dp) 

The coefficient of correlation between the two indices (ppu, SqP) and the two 
parameters mentioned above (hse, dp) was calculated. The correlation matrix obtained 
(table 5) shows that there is a significant correlation (P::;, 0.01) between the hse and dp 
parameters and the ppu index (no significant correlation exists between the hse and dp 
parameters and the SqP index). The correlation values are negative, meaning that. as 
the percentage of the surface area at high risk of soil erosion (hse) and the density of 
population (dp) increase, the fragmentation index (ppu) decreases. If ppu decreases, 
fragmentation is low and the areas at high risk of erosion are more concentrated. 
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Table 5. Correlationmatrixobtainedfromtable4 
showingthesignificantcorrelation (P.;;0.01) 

ppu 
SqP 
hse 
dp 

ppu 

-0.876 

SqP hse 

-0.676 -0.876 

Sate: ppu is the patch-per-unit index (fragmentation) 

SqP is the square-pixel index (complexity) 

dp 

-0.676 

0.808 

hse is the percentage of pixels with high risk of soil erosion 

dp is the density of population (per hectare) 



Ma1,:> 3. Digital elevation model (DEM) 
dEirived from aerial photos 1 :50,000, 

with a cell size of 25 metres 

Map 4., SlopE map subdivided into three percentage classes 

- no data 
slope: 0-<10% (mild erosion) 

R slope: 10-<20% (medium erosion) 
~ slope: >20% (severe erosion) 
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Map 5. Geomorphological map subdivided into nine classes (see table 1) 

8.30 

0 no data 

Alluvial plain and terraces (1) 

Erosion surface remnants with shallow soil 

Severe badlands 

4 Undulating badlands 

Scarps and denutational rock slopes 

6 Alluvial fans 

7 Alluvial plain and terraces (2) 

8 Erosion surface remnants with soil cover9 

Map 6. K-factor map obtained from the geomorphological units 
and subdivided into three classes 

no data 

mild erosion 

medium erosion 

severe erosion 



Map 7. C-factor map subdivided into four classes 

• no data 
D cover 100% or rock 
m open wood-scrubland 
D crops and bare soil 1 
18 bare soil 2 

Map 8. Potential soil erosion map subdivided into seven classes 

• no data 

D 1 1.0-3.5 
1~t~f!t: 1 l 2 3.5-4.5 
E2] 3 4.5-5.5 - 4 5.5-6.5 
R . 5 6.5-7.5 
EB 6 7.5-8.5 
D 7 8.5-9.5 
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Map 9. Patches map, showing the cultivated areas with the highest erosion risk, 
obtained using the GROUP program (each patch has a unique identifier number) 

5. Simulation of application of alternative land-cover types 

The simulation was carried out on an area of 841 hectares located in the Tsegereda/ 
Warerbe tabia (Tigray, Ethiopia). This tabia is characterized by high risk of soil erosion, 
by high population density (5.03 inhabitant per hectare) and by a high percentage of 
cultivated land (60.23 %). The aim of simulation is to study the effect of the conversion 
of a cultivated area of 84 hectares into woodland, supposing that the people previously 
living from this cultivated area (about 300 individuals) would find employment in a 
textile factory built in the vicinity. 

The various types of data were stored and processed in a geographic information 
system using IDRIS! and PCRaster softwares. Figures 1-7 illustrate the tools used to 
simulate the conversion of land. 
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Map 1 O. The study area in the Tigray region of Ethiopia 

Keni2t 

Map 11. Land-cciver map obtained from the Landsat-TM S satellite 
with the patches map (vector) superimposed 

simulation area 
no data 

Woodland 

Evergreen scrub 

Grassland 

Open woodland 

Bushland 

Cropland 1 

Cropland 2 

Cropland 3 

Cropland 4 

Bare soil 1 

Bare soil 2 

Rock outcrop 
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Figure 1. The GROUP program identifies all contiguous groups of cells 
with the same value; cells belonging to one patch are given a new unique value 

J ,/:-,//,,,},', > / / / ~ < :;'' ', 

/titnC,eL .·.·· · !land cover 
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~Output image: · <. 
! 

I patches map I 

fX Include diagonals 

Title: 

I 1 denlification of the patche~ 

Figure 2. The EXTRACT program provides for each patch the identifying number 
and the corresponding land-cover category value 
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Figure 3. The cutput from the program is saved in an ASCII file, 
which can be read by the database 

Figure 4. Tlie ASCII file obtained from EXTRACT imported 
into the database structure 
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Figure 5. Patch category 
values 

i Mbttfltiffti.MW.fr-u~Jolxl 
I File Modify Query Link Help 

102 6 
103 8 
104 3 
105 8 
106 1 
107 9 
108 6 
109 1 
110 7 
111 12 
112 
113 7 
114 2 
115 7 
116 6 

Figure 6. Modified patch category 
values 

Figure 7. Database workshop dialogue box 

In the table created by the database (figure 5) the patch category values (field 1) 
are modified (figure 6). The new category values are assigned to a new map using the 
ASSIGN option from the Link menu (figures 7 and 8). 
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Map 12. Image of study area prior to simulation 

The cultivated area of 84 hectares will be transformed into woodland. The dis­
play is created using PCRaster software. 

Map 13. Land-cover map showing simulation of the conversion of a cultivated 
area of 84 hectares into woodland. The display is created using PCRaster software 
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9 Appendix 

Multi-fold gr·ound penetrating radar 

Ground penetrating radar systems (GPR) are used to find and represent objects that are usually 
deep in the ground, but also objects in concrete walls. GPR can locate metal objects and, unlike 
many methods, can also locate non-metallic objects (such as plastic pipe, cadavers and void 
objects). The only requirement is that the materials have different electrical properties than the 
host material [ 1]. 

GPR is very similar to conventional radar in that an electromagnetic pulse is launched in 
a specific direction. The data consist of measurements of strength of reflections and time dura­
tion until the reflection is received. In the case of GPR, the electromagnetic pulse is launched into 
the ground and reflections are received from subsurface features where a change in electromag­
netic properties occurs. Because of the characteristics of many soils, the frequency content of the 
radar pulse is usually limited to the range of 10-100 MHz. This limit in frequency content sets 
the signal wavelength and thus sets the resolution of the target detail. The person operating this 
type of instrument must be able to interpret data variations to make predictions about subsur­
face characteristics. 

GPR is a highly effective tool for the non-intrusive and non-destructive evaluation of solid 
or subsurface objects. By tra 1smitting and receiving high-frequency radar waves from hand-held 
antennas, operators can acquire images of the underground structure much like above-ground 
radar is used to acquire im<tges of air planes in the sky. 

GPR is applicable to mapping and imaging locations of the following: 

0 Buried utilities 

0 Plastic, cement, asbestos, clay or metal pipes 

0 Underground storage tanks and service lines 

0 Hazardous waste and buried drums (metal and plastic) 

0 Archeological sites (e.g., foundations, burial sites and chambers) 

0 Forensic targew (bodies, weapons and drugs) 

0 Topsoil characteristics and shallow geological structures 

0 Dinosaur fossil'; and animal burrows 

0 Unexploded ordnance, plastic land mines 

0 Concrete structures (bridges and dams) 

Multi-fold ground penetrating radar (GPR) techniques for ultra-high resolution (UHR) 
investigation are applied to: 

0 Archeology 

0 Environment (site contamination studies, environmental risk assessment) 

0 Civil engineering 

1. How GPIR works: basic principles 

A radar system (figure 1) includes a radio transmitter and receiver, connected to a pair of 
antennas coupled to the ground. The transmitted signal penetrates a short distance into the 
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ground, and some of it reflects off any object with different electrical properties than the host 
soil. For example, since plastic pipe and voids do not have the same properties as soil, they will 
reflect the signal. There is a delay in the radio signal that reflects from the object in the ground. 
Echo sounds and fish finders work in a similar fashion. 

Figure 1. Radar system 

1. 1. Image construction 

To construct an image that the operator can interpret (figure 2), the radar plots the echo from 
the object on some sort of display, on a screen similar to a computer monitor. The radar is moved 
along the ground and each new echo is plotted alongside the previous ones. When enough of 

these signals are plotted side-by-side, the operator can see a pattern, which can be interpreted 
as an object. 

Figure 2. Image construction 

1.2. Hyperbola 

When the object is ahead of the radar, it takes more time for the echo to bounce back to the antenna. 
As the radar passes over the object, the time grows shorter and then longer again as the radar 
passes the object. This effect causes the image to take the shape of a hyperbola (figure 3). 
Experienced users recognize that a hyperbola is actually the image of a smaller object (for example, 
a pipe) located at the centre of the pattern. Other patterns are produced by different structures. 
For example, a buried tank might have a flat image with curves down from either end. 
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Fiigure 3. Samples from a hyperbola 

7.3. Resulting images 

The hyperbola results from crossing a pipe, but the image will be a straight line, since the 
distance from the pipe do1~s not change (figure 4). The problem is that other conditions will 
produce the same effect, e1;pecially layers in the soil, bedrock or the water table. It is difficult 
to map pipes by following them as is done with other locating methods. Instead, the antenna must 
be moved across the pipe tn a meandering or zigzag fashion. 

Figure 4. Ambiguity of the same images 

7.4. Effects of antenna pattern 

There are different types of antennas with different beam shapes. The most common antennas 
(dipole) have a very wide beam and horizontal polarization. Consequently, the hyperbolas are 
very wide. Log-spiral antennas (like those used on the GeoRadar lOOOB) have a narrow beam 
with circular polarization and the images are smaller. The difference is like comparing a flood­
light to a spotlight. (The two types are shown in figure 5.) The narrow beam on the GeoRadar 
system creates images that look more like the actual target, and closely spaced objects can be 
resolved. 
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Figure 5. Dipole antenna (left) and log-spiral antenna (right) 

7. 5. Determining the depth of the object (figure 6) 

It is not easy to determine the depth of an object without some knowledge about the dielectric 
constant in the local soil. The GPR can measure time very accurately, but the speed of the radar 
signal varies considerably with the soil type. In air, radar waves travel at 186,000 miles per 
second (or about 1 foot in one nanosecond). If one knows the dielectric constant (from experi· 
ence) or can look at the image of an object with a known depth, the GPR can be adjusted to read 
depth accurately. 

Figure 6. Determining the depth of the object 

2. How deep can GPR see? 

When radar signals penetrate the ground, they can attenuate rapidly depending on the soil type. 
The depth to which GPR can locate objects depends on the soil type, the size of the object, and 
the material contrast. 

As a general rule, GPR works well in many areas and can locate objects that cannot be 
found otherwise. The following conditions can determine the effectiveness of GPR: 

0 :vletal can be seen at greater depths than concrete or clay objects, which can be seen 
at greater depths than plastic; 

0 Large objects can be seen at greater depths than small objects; 

0 GPR is very effective in clean, non-metallic sands and non-conductive soils, but less 
effective in conductive soils like clay, especially wet clay; 

0 GPR is effective in fresh water but does not perform well in salt water. 

In good conditions, radar can reach 10 or 20 feet, but in bad conditions just a few inches. 
The pulse-video radar systems can use large/low-frequency antennas and reach several tens of 
feet, but with limited resolution. Such systems are good for mapping geological structures, but not 
for imaging objects. In many cases, changes in the geological structure can be seen (for example, a 
trench or grave) while the object (e.g., a pipe in the bottom of a trench) cannot be imaged. 
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3. Three-dimensional subsurface imaging 

In the future, ground-penetrating radar systems may provide three-dimensional images of objects 
in the subsurface. Figures 7 and 8 show three-dimensional images created by Roger Hackman 
with partial funding from the Electric Power Research Institute. The data were gathered with 
GeoRadar Inc. [Vlodel 1 OOOB ground-penetrating radar. The raw field record as viewed on the 
screen of the GPR is shown in GPR images. 

3. 1. Test pit 

Figure 7 shows the arrangement of pipes in a Lest pit. There arc two pipes at a depth of 2 feet, 
a T-shaped pipe that is 4-feet deep, and pipes at depths of 6 and 8 feet. ;\II the pipes arc metal, 
except for the U-shaped pipe. The test pit is dug in clay soil and flllcd with clean sand. 

Figure 7. Arrangement of pipes 

3.2. Computer processed image 

The data were acquired in a 4-inch (10-cm) twodimcnsional grid on the surface, then processed 
on a Silicon Graphics workstation using proprietary algorithms (developed by R. Hackman). The 
images were processed using Synthetic Aperture Processing and enhanced with a two-direc­
tional linear filter. 

Figure 8. Computer processed image 
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4. GPR applications 

4. 1. Target-detection applications 

GPR can be used for location and mapping of the following: 

0 Pre-screening of bore hole locations and excavations for the presence of subsurface 
utilities or other potential hazards; 

::I Detecting and mapping underground tanks, vaults and utility lines (electric, gas, 
water, sewer, TV cable etc.). GPR can locate plastic as well as metal lines; 

0 Detection and mapping of buried drums and other types of waste containers; 

0 Location and mapping of subsurface-waste disposal systems, septic systems, dry­
wells, leach fields, trenches and pits; 

0 Detection and mapping of sinkholes and voids for construction projects. 

4.2. Geologic-mapping applications 

Examples of applications in which GPR supports subsurface investigations include the following: 

0 \1apping of geologic features of importance to hydrogeologic investigations, such as 
the configuration of the water table and the bedrock surface; 

0 Detailed stratigraphic mapping of shallow sediments and/ or geologic units; 

0 Detection and mapping of hydrocarbon and chlorinated-solvent contaminant 
plumes in shallow unconsolidated media and in bedrock; 

j Detection and mapping of bedrock-defect structures such as faults, fractures and 

joints; 

0 GPR mapping of stratigraphy and contaminant-related GPR-signal anomalies can be 
used to guide the location of monitoring and remediation wells; 

0 Detection and mapping of sinkholes and voids. 

5. GPR usage and limitations 

According to L. Dolphin [2], GPR systems usually operate in the VHF-UHF region of the elec­
tromagnetic spectrum. The frequency used is a compromise. One desires to use the lowest 
possible frequency because low frequencies give reasonably high penetration depths into the 
earth. But a sufficiently high frequency must be selected so that the radar wavelength is short, 
allowing detection and resolution of small objects such as pipes. For cart-mounted radar, 
150 MHz is a typical centre frequency; however, 300 and 500 MHz are sometimes used for 
shallow, high-resolution probing, and frequencies as low as 20 MHz are used for locating deep 
caves or mine tunnels. 

GPRs are also known as "impulse radar" because the transmitted pulse is very short and 
is ordinarily generated by the transient voltage pulse generated from an overloaded avalanche 
transistor. Resistively loaded antennas are employed because one can not tolerate antenna ring­
ing. The distances in the ground where such radar look are measured from inches to tens of feet. 
This corresponds to travel times measured in nanoseconds, that is, billionths of a second. Short 
transmitted pulses imply wide radar bandwidths, so a GPR operating at a central frequency of 
150 .\1Hz actually radiates substantial energy from 75 to 300 MHz. 

The performance capability of this type of radar is strongly dependent on the soil electri­
cal conductivity at the site. If the soil conductivity is high, attenuation of the radar signal in the 
soil can severely restrict the maximum penetration depth of the radar signal. In California, 
Cnited States, for example, where soils in many areas are often high in clay content, the soil 
absorptive losses can be quite high. Whereas maximum penetration depth achievable with this 
type of radar can be tens of feet in favourable environments, these numbers are reduced to a 
few feet or less at many sites in California. · 
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GPR surveys should be performed in the dry season if at all possible. Soil moisture, 
especially in high-clay soils, only increases the radar attenuation rates, further limiting the radar 
performance. 

Spurious radar echoei (known as "clutter") can also be expected in many test areas be­
cause of buried debris such as old rails, wire scraps, boulders and small metal objects. Usually 
a trained operator can interpret the desired radar signatures in the midst of a moderate amount 
of such clutter. 

It is not possible to build GPR antennas so that the antenna beam width is narrow. The 
wide antenna beam width of cart-mounted ground-penetrating radar makes it difficult to resolve 
closely spaced objects, such as two parallel pipes in a common trench. In some cases the fill in 
the trench or the trench walls may be detected on the radar, but the pipes in the trench may not 
be radar discernible. Interpretation of GPR records is an art as well as a science. even with the 
best available state-of-the-art radar. 

In principle, ground-:r,enetrating radar are capable of locating plastic pipes as easily as 
metallic pipes since the radar signal reflection from the pipe depends on contrasting dielectric 
properties of the soil and pipe, not just a high electrical conductivity for the pipe. In actual 
practice GPR has the following limitations: 

0 Soil attenuation may restrict the use of GPR to shallow depths; 

0 The GPR antenna beam width is broad, making it difficult for radar to discriminate 
between closely spaced pipes; 

0 In disturbed ground, the radar may detect the walls of a trench, for example, but 
not the pipe it contains. 

Nevertheless GPR can be very useful when a thorough search of the site is required. GPR 
normally has an accuracy cf several feet or less when measuring the depth of a buried object. 

Cart-mounted GPRs rely on motion of the cart to generate a continuous radar record of 
traverse distance versus dtpth in the earth. GPR data are ordinarily recorded on video-tape, 
with voice comments for archive purposes, and printed out on thermal printer paper on-site for 
immediate analysis. The successful interpretation of GPR records is an art as well as a science 
requiring considerable opentor experience for good results. 
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